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Chapter 1 • Introduction 

Release Notes 
The following new features are present in the Telxon 7.0 release: 
 
• = There is a new authorization code scheme involving updates to the Twin Client 

Authorization screen and to the Connect web site. You are now able to enter more 
information on our web site while authorizing your terminal. Also, you may now add 
terminals to an existing OpenAir system. 

• = There is a new Manual Authorization button in the Authorization screen. Using this 
button is an alternate method of obtaining an authorization code for a terminal. 
Clicking on this button, and manually entering your mac address in the screen that 
appears enables you to generate individual authorization codes. 
 

• = There is a new Details button in the Authorization screen to prioritize Airloader 
options. Click on the Details button to number the options in its screen in the order of 
your priority. The options are moved using the Up and Down buttons in the 
Authorization Details screen. 
 

• = There is a new Listing button in the Authorization screen. Click on the Listing button 
to view authorization codes issued. The authorization codes in use along with their 
corresponding serial numbers will appear. 
 

• = There are new TN Plus options (Screen Watcher, Terminal Messenger, RF Monitor) 
in the Tools menu. With Screen Watcher, enter the terminal’s IP address and a screen 
will appear with a display resembling your terminal screen. With Terminal 
Messenger, you may enter a message to send, select the terminal to receive this 
message, and send the message. RF Monitor allows you to view a log of the 
terminal’s activity after entering its Terminal IP address and Terminal IP Port. 
 

• = There is a new server object Get/Save feature in the Servers screen of the Settings 
menu. Use its Load button if you want to load an .svr file. Use its Save As button if 
you want to save your file as an .svr file. 
 

• = There are new options in the Terminal Operations screen. "Use GUI menus and 
screens" is a CE option that makes the terminal program act more Windows-like. 
Additional options include check boxes to enable aggressive linear decoding and 
enable the centering beam during imaging.  
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• = There is a new Schedule button on the Group screen that is used for scheduling an 
automatic Airloader update. Click on this button to view a dialog box for scheduling 
an automatic Airloader update.  
 

• = There is a new Thin Mode button in the Terminal Auto-Configuration screen. This 
button enables you to cause all terminals in a group that are currently running in thick 
mode to be switched to thin mode the next time Airloader is run on the terminal.  
 

• = There is a new Server Transfer option in the Tools menu. You may enter your server 
address in its FTP Settings screen to send object editor and configuration files from 
Windows to your Linux box. 

The following are known deficiencies of the Telxon 7.0 release: 
 
• = Telxon 960SL: Upon first use of the unit after downloading the software to the 

terminal, the scan decoder does not recognize the default scan decode settings until 
after the unit has been powered off and on. After making changes to the decoder 
settings, the same power sequence must also be applied after first use. 
 

• = Telxon 960SL: The terminal specific New Environ option is not functioning. 
 

• = Telxon 860IM and 960SL: The full ISO-8859 character set is not supported. 
 

Overview of Connect, Inc.’s Product Line 
Connect, Inc.’s products bridge the gap between portable wireless devices and network 
applications, making the entire wireless enterprise as productive, efficient, and reliable as 
possible. The Connect, Inc. family of products supports the following: 
• = All Internet-compatible wireless networks, encompassing virtually all wireless LAN 

technologies on the market today. Spectrum One, a proprietary spread spectrum 
wireless technology in the 900Mhz band, is also supported. 

• = All Internet-compatible wire network media, including Ethernet. 
• = All major user interfaces, including HTML, VT/HP, 3270, and 5250. 
• = All possible network application architectures including direct client, client-server, 

and three-tier client server. 

The product line of Connect, Inc. consists of two major product families that work in 
unison to deliver a single, complete solution for the entire wireless enterprise. The focus 
of each of these products is described below. 
• = OpenAir: Hardware and middleware solutions for the wireless automatic 

identification industry. This family includes OpenAir Linux, OpenAir Windows, 
OpenAir 400, and the universal terminal client software, Twin Client. 

• = DataLinc: Application development tools for the wireless client-server environment. 
The family currently includes AirLinc for use with ODBC compliant databases. 
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Twin Client Overview 
Twin Client is a software package that provides VT100, VT220, HP700/92, TN3270 
(Telnet 3270), and TN5250 (Telnet 5250) emulation on portable terminals. It includes an 
easy-to-use Windows program for configuring and downloading the software to the 
portable terminals. 

Modes of Operation 
Twin Client operates in either of two modes: Telnet client or Server client.  
• = Telnet client mode provides a telnet connection directly to host computers and their 

applications.  
• = Server client mode communicates directly with an OpenAir or AirLinc server, which 

in turn provides the connection to host computers and their applications. 

The primary difference between the two modes is in processing load distribution: In 
Telnet mode, all application protocol processing is performed on the terminal, while in 
Server mode all of the processing takes place on an intermediate OpenAir or AirLinc 
server. Another important difference is optimization: In Server mode, the OpenAir or 
AirLinc server introduces display optimization, data compression, and several other 
techniques that can dramatically reduce wireless network traffic. These optimizations are 
not possible in Telnet mode. Additionally, the Server mode provides the ability to do 4 
Terminal Sessions.  

All of the user interface features, functions, and capabilities remain the same, regardless 
of the mode of operation. 

Major Features 
 
Twin Client for Telxon terminals offers the following benefits:  
• = Simplicity: Twin Client is preset to match the default keyboard overlays and 

functionality of the Telxon Telnet client. No special configuration procedures are 
required. 

• = Management: Administrators and integrators can monitor and modify the software 
revision and configuration of each portable terminal from any Windows PC attached 
to the TCP/IP network. Changes are downloaded to the terminals over the wireless 
LAN automatically. 

• = Formatting: The Twin Client Terminal Screen Formatter feature is built-in, allowing 
integrators to tailor host application displays to suit the needs of the terminal 
operators without modifying the applications. 

• = Internationalization: Error message language translations and character sets are 
menu selections. No additional integration is necessary. 

• = Migration: Conversion to an OpenAir or AirLinc client-server environment is 
automatic because the Server client is included in the Twin Client software already 
downloaded to the terminal. 
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In This Manual 
This manual is organized as follows: 
• = Chapter one provides an overview of the Connect, Inc. product line and an 

introduction to the Twin Client. 
• = Chapter two describes how to load the Twin Client Manager software on a Windows 

95, 98, ME, XP, 2003, or NT/2000 PC. 
• = Chapter three describes how to quickly configure the Twin Client Manager and the 

terminal for automatic, over-the-air software download and subsequent Telnet 
session startup. 

• = Chapter four describes how to change the Standard setup options specific to VT/HP, 
3270, and 5250 emulations.  

• = Chapter five describes how to use the Advanced setup options for VT/HP, 3270, and 
5250 emulations. These options are used to customize keyboard, display, scanner, 
timer, alarm, and printer operation. 

• = Chapter six describes how to use the Twin Client advanced integration tools to 
further customize terminal operation. The creation and use of mapping, macro, 
dialog, and scanner control objects are described. 

• = Chapter seven describes the use of the built-in Twin Client Formatter, and how to 
configure the portable terminal to use screen formatting. 

• = Chapter eight describes how to use the Airloader Auto-Configuration tool to manage 
and automatically maintain the software configuration of all terminals on the wireless 
network. Also described are software management procedures and options that are 
unique to Telxon terminals. 

• = Chapter nine is a reference for the ISO 8859-1 and ASCII character sets. 
• = Chapter ten is a reference for the default keyboard configurations for Telxon 

terminals using Twin Client in advanced mode.  Figures and tables are included for 
3270, 5250, and VT/HP. Also included for reference are the Telxon terminal control 
sequences. 

• = Chapter eleven is a reference for terminal error messages in Twin Client. 
• = Chapter twelve is a guide for using custom Telxon Airloader images.



 

 Twin Client Reference    •    June, 2004  2-1 

Chapter 2 • Installation 
This chapter describes the installation of the Twin Client software on a Windows 95, 98, 
ME, XP, 2003, or NT/2000 PC.  The software can be downloaded from the Connect web 
site. Instructions are provided below. 

Requirements 
Installation of Twin Client requires, at a minimum, the following: 
• = A Pentium-class processor  
• = 32 MB of RAM 
• = 10 MB of free hard disk space available 
• = Microsoft Windows 95, 98, ME, XP, 2003, or NT/2000 operating system 
 
The 860IM terminal requires, at a minimum, 
• = 256 K ARC space 
• = 1 MB RAM space 
 
The 960SL terminal requires, at a minimum, 
• = 5112 K ARC space  
• = 1 MB RAM space 

Downloading From the WEB 
1. Go to http://www.connectrf.com on the Partner Services page for PowerNet software.  

2. Click on the Software Download icon. 

3. Select the applicable Twin Client Manager software. 

4. Click on the Version number to download software. 

5. Click on Setup.exe and follow Installation Shield wizard. 

6. Follow the steps in the Authorizing Twin Client section of Chapter Four. 

Running Setup from a Download File 
The downloaded file is a compressed archive. After extraction using a utility such as 
WinZip or PKWARE, folders are created on the hard disk as shown in the following 
figure. 

http://www.connectrf.com/
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Click on the Disk1 folder to view the files as shown in the following figure. 

 

Click on the Setup application and proceed to the following section entitled Installation 
Wizard for further instructions. 

Installation Wizard 
The InstallShield wizard runs and presents the following screen. 

 
Click on Next to begin the installation process.  
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To change the default Destination Location, click on Browse and select a location. Then 
click on Next.  

 
The default folder is Twin Client. This default may be changed either by selecting an 
existing program group or by typing in a new name at the prompt. Then click on Next.  
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Read the warning. Select Yes to continue with the installation, or No to close the setup. 

 
When the installation is complete, reboot the system to initialize the Twin Client 
software. 

a. To reboot the system immediately, click on Finish.  

b. To reboot later, click on the option to restart the computer later, and click on 
Finish.  
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Running the Manager 
The Twin Client Manager is the utility that manages the terminal software and 
configurations. Select Start, Programs, PowerNet and Twin Client Manager.  

Note: If the PowerNet splash screen flashes for a second and ends when the Twin Client 
manager is run, move the file at this link 
(http://www.connectrf.com/Documents/fix-flash.reg) to the system with the 
problem and then run it. This issue, found in earlier versions of the Twin Client 
manager, has been fixed in later versions by using a later MS compiler and 
libraries. 

The Twin Client Manager screen appears as shown in the following figure. This is the 
administrator's main screen, and all functions are accessed from its menu bar, tool bar, 
and tabs. 

Menu Bar 
The menu bar provides access to the functions used to configure the terminals and 
manage their software. Subsequent chapters of this manual explain each menu and its 
options.  

 

 

Toolbar 
Under the menu bar, the tool bar provides shortcuts to major features. The toolbar can be 
turned on or off by changing the Toolbar parameter found on the View menu. The 
shortcuts available from the toolbar are as follows: 

 Create a new terminal configuration. 

 Open an existing terminal configuration. 

 Save the current terminal configuration. 

 Download the configuration to terminal. 

 Download software to terminal. 

 Automatically configure terminals over the wireless network. 

 Twin Client Manager version. 

http://www.connectrf.com/Documents/fix-flash.reg
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The Twin Client Manager is now successfully installed and ready for use. The next 
chapter provides detailed instructions for quickly configuring the terminal and starting a 
telnet session. 
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Chapter 3 • Quick Start 
This chapter describes how to prepare the Twin Client Manager and the Telxon terminal 
for a Telnet session with the host. Following an initial serial download, the terminal 
software and configuration is managed automatically, over the wireless network. 

Note:   Telxon terminals are normally delivered with Telxon files pre-installed. However, 
if the terminal does not have those files installed refer to Chapter 8, Downloading 
Telxon Files, before proceeding. 

Configuring the Manager 
The first step is to configure the Twin Client Manager to meet site-specific requirements, 
and then prepare it for the automatic management of the terminal software and IP 
addresses. This simple procedure will require only a few minutes to complete. 

Setting the Emulation 
Click on Start, Programs, PowerNet and Twin Client Manager. Select the Settings 
menu as shown below. 

 

Click on Emulation, select the desired emulation, and then click OK. 
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Setting the Servers 
The Servers are the Telnet host systems the terminals will access. 

 

To set these addresses from the Settings menu, click on Servers and then click on Add. 
Enter the name of each server, its IP Address and IP port (normally 23 for Telnet 
servers), and emulation type. Then click on OK.  

 

Repeat this step for each telnet server the terminals are required to access. If an error is 
made in the name, IP Address, IP Port number, or Terminal emulation type, click on the 
line that is in error and then click on the Edit button to make the corrections. Use the 
Load button if you want to load an .svr file. Use the Save As button if you want to save 
your file as an .svr file. 
 
Some DOS terminals support DNS (Domain Name System) host lookup to determine the 
host address.  
 
To set this up, key in the full DNS name in the "Server Name" field and set the IP address 
to 0.0.0.0. 
 
You can determine if your device supports this by looking for the presence of a DNS 
setup option under "Terminal Setup" (Shift C). 
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When the client sees the address of 0.0.0.0, it will issue a DNS lookup on the value in the 
"Server Name" field to determine the true IP address. 
 
Please make sure that you have DNS set up on the terminal. Use the Shift C menu. 
 
You can also "Test" the DNS name lookup in Twin Client manager (if the Windows PC 
is using the same DNS server as the RF terminal).  Just click on the "Lookup" button and 
the true IP will be returned in the IP address field. 
 

 
 
Please make sure to set the address back to 0.0.0.0 before sending this to the terminal. 
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Setting Terminal Operations  

In the Twin Client menu under Settings, choose Terminal Operation. 

 

The Run Airloader on terminal option can be checked, and the Airloader server IP 
address can be entered, as shown below.  

 

Click on OK when finished. 

Setting Terminal Model and COM Port 
The default serial connection to the Telxon terminal is through COM1. To select a 
specific Telxon terminal model, or to change the COM port assignment, click on the 
Options menu as shown. 

 

The default terminal model, 860-960, represents the default setup for all Telxon terminals 
under Twin Client.  
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Saving the Configuration 
Click File, Save As, and enter a name for this configuration.  

 

 

For the purposes of this example, the name is vt220. 
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Setting Airloader Auto-Configuration 
The configuration download and IP address assignment for each terminal will take place 
automatically by setting the Airloader Auto-Configuration options. 

 
 

Click on the Airloader option in the Tools menu.  

Note:   If the Airloader Auto-Configuration window does not display the options, click 
on the Advanced>> button. 

If multiple network adapters are installed on the PC, ensure that the desired network 
adapter is selected. Click the Change button to select the appropriate adapter. 
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This powerful software management tool is described in detail in Chapter 8. For now, it 
is sufficient simply to use it for assignment of the initial terminal configuration and IP 
address, all of which can be easily changed later. Ensure that all of the check boxes are 
checked as shown above. 

Click on the Addresses button to assign user specific IP address range. 

 

After setting the address range, click on OK to return to the Airloader Auto-Configuration 
screen and then click on the box next to the terminal group manager. 
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The display expands to include the default terminal Group. Next, click on the New 
Group icon and use the Browse button to select the configuration file saved earlier. 

 

Check the Active box, and the system is now configured to automatically download IP 
addresses, software, and configuration files to the terminals. Click on the  box at upper 
right corner to return to the main menu. 

Note:   The software does not need to be authorized now. It can be authorized later, after 
a Telnet session has been established. The procedure is described in Chapter 4 
section entitled Authorizing Twin Client. 
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Selecting the AirLoad File 
 

For instructions on creating AirLoad files, see Creating Telxon Arc Files.  

The AirLoader ARC file itself is downloaded through the serial connection as described 
in Configuring the Terminal for Download. 

Configuring the Terminal for Download 
Command Safe Boot 
The Command Safe Boot bypasses all configuration files and places the terminal in DOS 
Mode. On the portable terminal, boot the terminal as shown in the following table. 
 

Safe Boot Sequences 
Following Power Off 

Terminal Model & Keypad Key Sequence 
960 5250, 45-Key 
TN3270 960/SL, 45-Key 

Press and hold the - and Tab keys, 
then press and release On/Off. 
Release - and Tab keys when cursor 
appears in the upper left corner of 
terminal screen. 

PTC-960SL, 45-Key Press and hold the Ctrl and Enter 
keys, then press and release On/Off  
Release Ctrl and Enter keys when 
cursor appears in the upper left corner 
of terminal screen.  

V-Term, 54- Key 
(VT-100, VT-220, HP-700) 
 

Press and hold the V and Enter keys, 
Press and release On/Off. 
Release V and Enter keys when 
cursor appears in the upper left corner 
of terminal screen.  

TN3270 PTC-860IM 
TN5250 PTC-860IM 

Press and hold the Enter and Tab 
keys, Press and release On/Off. 
Release Enter and Tab keys when 
cursor appears in the upper left corner 
of terminal screen.  

Once the keys are released the terminal screen will scroll. The following should be 
displayed on the terminal screen. 
 

Copr. 1990, 1995 Telxon Corp. 
RAMSAVER V6.2 (3.0/3.0) 
 
Current Date is: (Example Wed 08-08-00) 
 
Enter new date: (mm-dd-yy): _ 
 
Current time is: (Example12:53:03.86p) 

Enter new time: _ 
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The terminal will display the current date and time. If the display is not accurate enter 
manually. 

Press Enter for models (PTC-960SL), (VT-100, VT-220, HP-700) and/or Tab for 
(TN3270 PTC-860IM, TN5250 PTC-860IM). 

The terminal will scroll to a DOS prompt (C>), type flashr and press Enter. 
 

Microsoft ® MS-DOS ® 
ROM Version 5.00 

© copyright Microsoft 
Corp  1981-1991, (3.0) 

C> flashr 

The next terminal screens appear as follows. 
 

FLASH –VER 1.3 
0: System ctrl 
1: User ctrl 
2: Exit 

Press 0, then Enter. 
 
Do you wish to program  
the flash now? 
(Y/N): y  

Press Y, then ENTER. 

Downloading the ARC Image 
The download requires approximately 5 minutes to complete, during which the following 
is displayed on the Twin Client Manager PC.  

 
FLASH Program 
Now operating 
Please wait  

Note: The file size may vary. 

In the event of a failure, verify the following: 
• = The cable connection between terminal and PC and condition of all connectors. 
• = The specification of correct COM port. 

Following a successful AirLoad ARC file download, the terminal automatically reboots. 

The terminal then associates with an access point, contacts the Twin Client Manager, and 
then downloads the program, configuration, and IP address of the terminal. 

During the download, progress messages are displayed on the terminal. Pauses in activity 
of up to 10 seconds will be observed as the terminal writes to EEPROM. The download 
requires approximately 1 minute to complete. 
 
Note: To change emulations with Airload: 
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1. Go to the DOS prompt at the a:/ drive. 
2. Delete the current emulation executable and the run.bat file. 
3. Set up Airload for the new emulation (example: C:\PowerNet\TwinClient                         
       \3270.cf) in the configuration file box of the airloader auto-configuration 

screen.          
           4.   Reboot the terminal. 

The following table describes the error messages that will be displayed on the terminal in 
the event of a download failure, and can be used as a guide to correcting the problem. 
 

Error Indication Possible Cause Corrective Action 
 

NOT Associated Invalid NETID or ESSID Run CFGRF or CFG11 radio setup 
program. 

No AirLoad Manager 
Found 

AirLoad Manager not 
active, or not installed 
on the LAN segment 

Ensure that the PC with Twin Client 
Manager is on the same segment and 
that the PC is operating. If the PC is 
not on the same segment, enter the 
address of the PC in response to the 
terminal prompt. 

Manager not Active Previously identified 
AirLoad Manager is no 
longer found. 

Same as above 

Unable to open 
connection 

IP stack on terminal 
failed to load 

Reload Telxon driver files. 

Timeout waiting for 
data 

Transient 
communications failure 

Reboot terminal. If problem persists, 
check the RFSYNC.log in the 
TwinClientTN directory. 

Download aborted Socket closed during 
download 

Ensure PC is operating. Reboot 
terminal and retry. 

Manager inactive PC not operating Restart the PC. 
Transfer successful,  
2 second download, 
terminal still in flashr 
program screen 

Memory too small in 
terminal to load custom 
ARC 

Use AirLoad ARC image. 

Transfer successful, 
terminal displays bad 
command or file 
name, and you are at 
the DOS prompt 

Incorrect radio type 
selected under 
Settings, Options for 
the terminal 

Correct radio setting and download 
again. 

 

A successful wireless connection and download is indicated by the display of the Twin 
Client main menu shown below. 
 

Twin Client 
© 1991-2004, Connect, Inc. 
 
Keypress to Continue  

The terminal is now ready to establish a Telnet session with the host system. 
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Starting a Telnet Session 
At the Twin Client main menu on the terminal, press any key to establish the connection. 
Until the terminal has been authorized, the following screen is displayed. 
 

RECOVERABLE ERROR 
Terminal not 
Authorized for 
Twin Client 
 
Keypress to Continue  

It is not necessary to authorize the terminal at this time, so press any key to continue. The 
terminal will establish a connection with the host system and start emulation. If the 
terminal fails to connect to the host, refer to the following table for the possible causes 
and the related corrective actions. 
 

Failure Cause Corrective Action 
Incorrect Host IP address Correct the Host List address on the terminal. 

Refer to Terminal Setup Using Twin Client Menus 
in Chapter 4. 

Incorrect netmask value Access Radio Setup menu and correct the 
netmask value. Refer to Terminal Setup Using 
Twin Client. 

After a Telnet session has been successfully established, the terminal will remain in 
session for a maximum of 30 minutes at a time until it has been authorized. Once 
authorized, there is no software restriction the session time. The instructions for 
authorizing the terminal are presented in Chapter 4. 
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Chapter 4 • Standard Setup 
The default terminal setup is sufficient for most installations. However, to meet site-
specific requirements it may be necessary to customize terminal operation. The standard 
setup options simplify this process and can be modified using any one of the following 
methods: 
• = Using the Twin Client Manager. 
• = Using the Twin Client terminal menu system. 

To simplify the installation of Telxon terminals at existing sites using Telxon terminals 
running Telxon TN Client software, the customized Telxon configuration files can be 
imported and automatically converted to Twin Client.  

This chapter describes how to use the Twin Client Manager, the terminal menu systems, 
and barcodes to setup the terminal. Also described are the methods for authorizing the 
terminal software. 

Setup Using Twin Client Manager 
The Twin Client Manager provides a Standard Settings tab for automatic setup of the 
terminals. The options within this tab vary according to the emulation selected, each of 
which is described in the following sections. 

VT and HP Settings 
Select the VT and HP emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below. Click on Standard under the View menu to access the 
Standard Settings tab. 

 

Then click on the VT100, VT220, or HP700 selection, as shown below.  
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Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for VT/HP emulation. 

 
 

Quadrant Mode  

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Font Size 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 

Key Click 

This option is used to automatically transmit a keystroke to the vt100 host when the 
vt100 field matches the selected attribute. The automatic keystroke generation can be 
based on whether the input is scanned, or keyed, or both. 
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Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
no printer is attached. 
 

5250 Settings 
Select the 5250 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below.  

 

Then click on the 5250 selection, as shown below.  

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 5250 emulation. 
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Quadrant Mode  

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

Font Size 
 

These check boxes enable (checked) or disable (unchecked) the display of characters in 
double high and double wide font. 

Key Click 

This option is used to automatically transmit a keystroke to the 5250 host when the 5250 
field matches the selected attribute. The automatic keystroke generation can be based on 
whether the input is scanned, or keyed, or both. 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
no printer is attached. 
 

3270 Settings 
Select the 3270 emulation setup by clicking on the Settings menu and then the 
Emulation menu, as shown below.  
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Then click on the 3270 selection, as shown below.  

 

Click on OK after the selection is made, and return to the main Twin Client Manager 
menu. The standard settings tab will now reflect the settings for 3270 emulation. 

 

Quadrant Mode  

This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 
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Double High and Double Wide Font 
 
These check boxes enable (checked) or disable (unchecked) the display of characters in 
the double-high and double-wide fonts. 

Key Click 

This option is used to automatically transmit a keystroke to the 3270 host when the 3270 
field matches the selected attribute. The automatic keystroke generation can be based on 
whether the input is scanned, or keyed, or both. 

Printer Type 
 

This scrolling list selects the attached printer type. The default value is none, indicating 
no printer is attached. 

Terminal Setup Using Twin Client Menus 
The Twin Client terminal software provides an internal menu system for configuring 
certain parameters on the terminal and for switching between "Server" and "Telnet" mode 
of operation.  To access this menu system, press uppercase C at the startup screen as 
shown in the following figure. 
 

Twin Client 
© 1991-2004, Connect, Inc. 
 
Keypress to Continue  

The next screen displays the edit functions. Cursor to the appropriate Edit Function and 
press Enter. 
 

Edit Menu Options 
Edit Mobile Unit IP 
Edit Server/Host IPs 
Edit Radio Option 
Edit License Key  
Run Site Survey 
Switch Client Modes 
Run Client Emulator 
Exit to OS 

Use the Up-Arrow and Down-Arrow keys to navigate the menu, and press Enter to select 
the highlighted option. Each menu option is described below. 

Edit Mobile Unit IP  
The IP list contains the terminal IP address, the Subnet Mask and the Router IP address. 
Enter the appropriate address and select <F3> to save and/or <F7> to Quit. 
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IP  206.232.71.38 
SN  255.255.255.0 
RT  206.232.71.1 
<F3> Save  <F7>  Quit  

Edit Server/Host IPs 
If the host IP address or addresses were not pre-configured as described earlier in the 
section Setting the Servers, or if you wish to change those settings using the terminal 
menus, select this option and enter up to four Host IP addresses as required. 
 

     Host 0 
IP 206.183.67.155 
Port 23__ 
 
<F3> Save <F7> Quit 

Press F3 to save the configurations. 

Edit Radio Option 
This function acts as a password to join the radio network.  Terminals associating with an 
Access Point must supply a matching value, determined by their configurations, or their 
association requests will be ignored. 
 
ID  tsunami____________ 

<F3> Save    <F7> Quit  

Edit License Key 
The client software can be authorized automatically, as described in the next section. This 
menu option permits authorization of each terminal manually. Select this option to obtain 
the terminal's Identification Code, which is then used to obtain the Authorization code 
from the Connect web site as described in the next section. 

The 12-digit value displayed at the top of the terminal screen is the Identification Code 
for the terminal. 
 

00A0F826E614 
Authorization 
    ______________ 
 
not authorized 
 
<F3> Save <F7> Quit 

Type the authorization code into the field as it appears on the WEB site. Punctuation 
characters, such as the hyphen (-), are required. Press F3 to save the authorization code. 
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Run Site Survey 
This option (a feature of Spectrum 1) is applicable to Release 5.0 and may be obsolete for 
your terminal. 

Switch Client Modes 
The Twin Client normally operates in "Telnet" mode, which provides direct connection 
to Telnet hosts. It can also operate in "Server" mode, through an OpenAir server. Select 
this menu option to switch between Server and Telnet modes of operation. Note that the 
host socket address for the OpenAir servers is 1800, which must also be changed in the 
Edit Server/Host IPs menu described above. 

Run Client Emulator 
After all desired changes have been made, select this option to return to the Twin Client 
main menu. Then press any key to establish the Telnet session and begin emulation. 
Refer to the Chapter 3 sub-section, Starting a Telnet Session, for further instructions. 

Exit 
After all changes have been made, scroll to exit. Selecting exit will exit you from the 
Emulator mode and bring you to the A:> prompt. 

Authorizing Twin Client 
 

Each PowerNet Twin Client will run for 30 minutes at a time without authorization.  
Uninterrupted operation for a production environment is the result of authorizing the 
software.  

The Twin Client Manager can automatically authorize the terminal over the wireless 
network if the following requirements are met: 
• = A PC running Twin Client Manager is connected to the wire LAN segment with at 

least one access point within range of the terminal. 
• = The AirLoad ARC file is installed on the terminal. 
• = The System ID of the PC on which Twin Client Manager is installed has been used to 

obtain a site license Authorization code from the Connect web site. 

To obtain the System ID of the Twin Client Manager, click on the Authorization option 
in the Tools menu, as shown below. 
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The Authorization window is displayed as shown below. 
 

 
 

 
Go to http://www.connectrf.com. Click on Partner Services. Click on the Generate 
Authorization icon at the top of the page. Follow the directions on the web site. 

Authorized Terminals 
The number of terminals authorized, the number of terminals in use, and the number of 
terminals remaining is provided in the Authorized Terminals box on the lower left side of 
the screen. 

Click on the Details button to number the options in the screen below in the order of your 
priority. 

Note: The terminal may or may not be able to utilize the Formatter feature depending on 
its authorization codes. 

http://www.connectrf.com/
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Click on an option and move it using the Up and Down buttons.  

Click on OK when finished. 

The Manual Authorization button is an alternate method of obtaining an authorization 
code for a terminal. This method does not utilize Airloader, as does the other method. 

Click on this button, manually enter your mac address in the screen that appears, and 
click on OK. This enables you to generate individual authorization codes.  

Adding Licenses 
The Add Licenses feature is used when adding additional licenses to an already site 
licensed Twin Client manager.  

An example of this is the instance in which Twin Client manager is licensed for 10 
licenses, and the customer purchases another 10 licenses to make a total of 20 licenses. 

From Twin Client manager, choose Authorization from under the Tools menu.  

Click on the Add Licenses button. 



  Authorizing Twin Client 

Twin Client Reference   •    June, 2004    4-11

 

A pop-up box appears with the machine ID and a space for the additional licenses 
authorization code.   

 

Enter the additional license’s authorization code and click on OK. 

Use the machine ID in the pop-up box instead of the original machine ID to get your 
authorization code.   

If adding users, click on the Add Licenses button before generating the authorization 
code to get the most current machine ID. 
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Transferring Authorization 
 
The Transfer Authorization feature is used when moving a site license from one PC to 
another.   
 
After Twin Client manager is installed on a new PC, you will need the system/machine 
ID for it.  This ID appears in the first box of the authorization screen. 
 
From Twin Client manager, select Authorization from under the Tools menu. 

 
Click on the Transfer Authorization button on the old PC.  
 
You will be asked for the new system ID.  Enter this new system ID.  It will generate an 
authorization code for the new PC's Twin Client manager.  

 

 
 
 

Note: This feature only works if there are licenses remaining on the old PC.   
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Listing 
Click on the Listing button to view authorization codes issued.  

The authorization codes used along with their corresponding serial numbers will appear. 

 
 
Click on OK when finished. 
 
Click on the Close button when finished. 
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Chapter 5 • Advanced Setup 
The Twin Client permits the customization of all aspects of terminal operation without 
custom programming. This chapter describes all of the advanced setup options. 
Additional advanced customization features, such as using the Object Editors, are 
described in Chapter 6. 

Selecting the Advanced Setup 
To change to the Advanced mode, click on the View menu and then on Advanced. 

 

As a result, a new set of tabs is displayed, as shown below. 

 

The following sections in this chapter describe each of the tabs and the options within 
each tab. 
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Customizing the Keyboard  
Clicking on the Keyboard tab displays the setup options related to the terminal keyboard 
and its operation. 

 
 

End Key 
This scrolling list selection is used to set the terminal key that terminates both the host 
connection and the wireless session. The default is PF10. 

Auto Send Key 
This scrolling list selection is used to set the keystroke to be sent automatically by the 
terminal when an input field on the terminal is filled with keyed input. That is, if an input 
field is 9 characters long, and 9 characters are manually keyed into the field, the Auto 
Send key is automatically transmitted with the 9 characters.  The default is Tab. Selecting 
noop disables this feature. 

Note: Selecting the Length Check option on the Scanner tab disables the Auto Send Key. 
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Key Click 
This check box enables (checked) or disables (unchecked) audible key clicks from the 
terminal. Default is on (checked). 

Case Conversion  
This scrolling list selection allows automatic conversion of keyed input to upper or lower 
case. The default value is none, meaning no conversion takes place.  

Mapping Object  
This feature of Twin Client allows for custom keyboard development. For example, the 
Tab key can changed to generate a PF4. This is an advanced integration tool and its use is 
described in Chapter 6.  

Macro Object (VT/HP Only)  
This feature is used to assign a key sequence to a specific terminal key. For example, the 
PF1 key can be set to generate a sequence such as receiving. This is an advanced 
integration tool and its use is described in Chapter 6. 

Mode (VT/HP Only) 
This scrolling list selection controls the transmission characteristics of the VT/HP 
emulations. In char mode, each keystroke generates an individual transmission. In block 
mode, a transmission takes place only after a control key, such as Enter or a PF key, is 
depressed. The block mode is more efficient. Refer to Chapter 6, Advanced Display 
Options for VT/HP, for more details on setting block mode operation. 

Note: When set to char mode, the Collection timer value in the Timers tab should be set 
to between 30 and 50 milliseconds for maximum performance. 

Auto EOF (3270 only) 
This check box option enables (checked) or disables (unchecked) the automatic erasure of 
all data in a field prior to keyed or scanned data input. The default value is disabled 
(unchecked). 

Clear First (3270 only) 
This check box option enables (checked) or disables (unchecked) the automatic erasure of 
all data in a field prior to keyed or scanned data input. The default value is disabled 
(unchecked). 

Advanced (3270 only) 
Clicking the Advanced button brings up the Advanced 3270 Keyboard screen and 
provides a variety of special key generation options. This is an advanced integration tool 
and its use is described in Chapter 6. 
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Customizing the Display 
Clicking on the Display tab shows the options related to the terminal display and its 
operation. 

 
 

Quadrant Mode  
This scrolling list option defines the rules by which the terminal display is positioned in 
the larger host display. As defined by Twin Client, quadrants are fixed position 
"windows" in the host display, and the terminal display is located on whatever quadrant 
contains the current cursor position. 

= Off disables quadrant processing and Twin Client simply centers the current host 
input field in the terminal display.  

= On enables quadrant processing. However, input fields that cross quadrant 
boundaries result in a shift to the left in order to locate as much of the current input 
field on the terminal display.  

= Soft always positions on a quadrant boundary regardless of input field boundaries. 
Viewing keys are enabled. 

= Hard is the same as Soft except the viewing keys are disabled.  

 Lock locks the terminal display origin (upper left corner) to fixed row and column 
(x,y) coordinates in the host display. The coordinates are zero-based.  
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Lock Row defines the Y coordinate for display position locking. Range is zero (0) to 
maximum number of rows on the host screen. Default is zero (0).  

Lock Column defines the X coordinate for display position locking. Range is zero 
(0) to the maximum number of columns on the host screen. Default is zero (0).  

Scroll Mode  
This scrolling list option selects the rule used for moving the terminal display within the 
host display using the viewing keys. 

= Half scrolls the terminal display in half-screen increments. For example, given a 16-
column screen, the screen is scrolled left and right 8 columns at a time. 

= Full scrolls the terminal display in full screen increments. For example, given a 16-
column screen, the screen is scrolled left and right 16 columns at a time. 

Language 
This scrolling list option selects the display character mapping and the translation table 
used for error messages displayed on the terminal. The default value is English. The file 
umsgs.txt, which is installed with Twin Client, contains all of the current language 
translations. 

In the event a specific language is not translated, or if a specific message is not correctly 
translated, visit the Connect web site at http://www.connectrf.com and check the Support 
page for a related Tech Note. If the issue has not been addressed, email 
support@connectrf.com and request a Product Change Request (PCR). 

Cursor Appearance 
This scrolling list option selects the manner in which the cursor is displayed on the 
terminal. The default value is hard. 
Type Appearance 
soft Blinking Underscore (_) 
hard Blinking Block     � 
hide None 

Mapping Object 
This feature is used to modify the displayed character set. This is an advanced integration 
option and its use is described in Chapter 6. 

Dialog Object 
This feature is used to build session automation scripts, and is an advanced integration 
option described in Chapter 6. 

http://www.connectrf.com/
mailto:support@connectrf.com
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Formatting 
This feature is used to re-format the host display onto the terminal display. This is an 
advanced integration option and is described in Chapter 6. 

Relocation Group 
This option group allows rows of the host display to be relocated automatically. This 
option is particularly useful when the application generates important error messages on a 
specific row that is not necessarily within the terminal's display area 

Source  

Defines the starting row (zero-based) in the host display that is relocated to the 
destination row of the host display. The default is zero (0). 

Destination  

Defines the starting source row location (zero-based) in the host display. Default is zero 
(0). 

Row Count 

Specifies the number of host display rows to be relocated, starting with the row defined 
by the Source option and continuing from top to bottom of the display. The default, zero 
(0), disables row relocation. 

Move Blank  

This check box enables unconditional relocation (checked), or enables relocation only 
when data is present on the source row or rows (unchecked). The default is unchecked. 

Reverse Video 
This check box enables (checked), or disables (unchecked), the processing of the reverse 
video display attribute on the terminal. The default value is on (checked). 

Wait Message 
This check box enables (checked), or disables (unchecked), the display of the message 
Waiting for Data on the terminal display. This message is used to indicate that the 
terminal has transmitted data to the host application and is waiting for a response. The 
default value is enabled (checked). 

Default Data (3270/5250 only) 
This check box enables (checked), or disables (unchecked), editing of data present in the 
current input field prior to entry of new data by the terminal operator. 
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Double High and Double Wide 
These check boxes enable (checked), or disable (unchecked), the display of characters on 
the terminal screen in double high and double wide fonts, respectively. 

Advanced (VT/HP only) 
This button accesses setup options for controlling all aspects of VT display attribute 
mapping and masking. This is an advanced integration tool and its use is described in 
Chapter 6. 

Customizing the Scanner 
Clicking on the Scanner tab shows the options related to the terminal scanner and its 
operation. 

 
 

Send Key 
This scrolling list option defines the control key automatically transmitted with scanned 
data. The list of keys depends on the type of emulation in use. The noop key indicates 
that no automatic control key will be sent. The default value is Enter. 
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Scan Ahead 
This scrolling list option defines the number of scans that can be transmitted by the 
terminal without a response from the host system. The maximum is 24, and the default  
is 1. 

Set to 0, scan ahead is disabled and you cannot scan again until the host response has 
been received. 
Set to 1, there is no scan ahead limit. 
Set to 2 and above, and the software will let you scan that many times until a host 
response is received.  So if you set it for 3, it will allow you to scan only 2 more times 
before the host responds to the first scan. 

Length Check 
 
With Length Check off, and Auto Enter key set to "noop": Keyed or scanned input 
that is equal to or greater than the field length results in an error "Entry Too Long" and no 
data is transmitted. 
 
With Length Check off, and Auto Enter key set to anything other than "noop": 
a.   Keyed input equal to the field length: The data and the specified Auto Enter key are                        
      transmitted. 
b.   Keyed input greater than field length: This is not possible, due to a) above. 
c.   Scanned input equal to or greater than the field length: The data is transmitted. If the                       
      data is greater than the field length, then that data is distributed among the subsequent                     
      input fields and the Scan Termination key is transmitted (unless it too is set to noop"). 
 

With Length Check on: The Auto Enter key and its functionality are disabled for both 
scanned and keyed input. 
 
There are specific functionalities related to the various settings of length checking and the 
Auto Enter key.  Setting the Auto Enter key to "noop" disables the Auto Enter function 
(i.e., automatic transmission of data when the field is filled or overfilled) for both 
scanned and keyed input.  When it is set to anything other than "noop", keyed and 
scanned input is distinguished and the Auto Enter key is effective only for keyed input. 
Scanned data that is equal to or greater than the field length is terminated with the Scan 
Termination key instead of the Auto Enter key. 
 

Note: Enabling Length Check disables the Truncation option (described below). 

Truncation  
This check box option enables (checked), or disables (unchecked), the automatic 
truncation of scanned data that is greater than the length of the input field. With both 
Truncation and Length Checking disabled, oversized scans are automatically applied to 
subsequent input fields as needed. If either option is enabled, this automatic application is 
disabled. The default value is disabled (unchecked). 
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Stripping 
This scrolling list option controls the rule for automatically removing trailing spaces and 
underscore characters. The rules are defined as follows: 

Rule  Operation 
off  No stripping is performed. 
space  Trailing spaces are stripped. 
score  Trailing underscores are stripped. 
both  Both trailing spaces and underscores are stripped. 

Binary-128 
This check box enables (checked), or disables (unchecked), the processing of binary code 
128 bar codes on the terminal. The default value is enabled (checked). 

Caution: If this option is disabled and binary-128 barcodes are used, the results are 
unpredictable. 

Data Mapping, Data Editor, and Decoder Control 
These are advanced integration tools and are described in Chapter 6. 

Scanner Type 
This scrolling list option defines the type of special scanner attachment in use, if present.  

External Scanner Setup 
 

RF terminals can be ordered with an Internal scanner or they can also support an external 
scanner. The external scanner is connected to the bottom of the terminal through the 
serial port. This requires the RS232 adapter be installed. The external scanner can be 
made to work even if an internal scanner is present. However, scanner decoder controls 
only apply to the internal scanner as we only have access to the internal decoder. 

The external scanner must be a serial based scanner. These are scanners that have on 
board decoder hardware/software and output their signals by normal RS232 signaling 
methods.  These external scanners are controlled by their respective manufacturer’s 
program controls provided in the manual accompanying the scanner from the 
manufacturer. 
 
The following is an example of a setup for an RF terminal. 

This is the order in which to set up the scanner.  

1 - (SET RS-232C DEFAULTS)  

2 - (SET ALL DEFAULTS)  

3 - RS-232 HOST BAUD RATE (9600)  
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4 - RS-232 HOST PARITY (NONE)  

5 - RS-232 HOST DATA TRANSMISSION FORMATS (<DATA><SUFFIX>)  

6 - RS-232 HOST PREFIX/SUFFIX VALUES (SUFFIX)  
 
7 - RS-232 HOST PREFIX/SUFFIX VALUES (<1><0><1><3>) 

Setting Log Levels 
The terminal maintains a logging facility that can be used by Technical Support and 
Engineering to assist in problem resolution. These levels should always be set to zero (0).  
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Customizing Timers 
Clicking on the Timers tab shows the options related to the terminal timers, as shown 
below. 

 

Timers Group 
Radio 

This numeric input field defines the length of time, in seconds, during which the terminal 
activates the radio and waits for a response from the host application. After the time is 
exceeded, an error message is displayed on the terminal. The default value is 120. 

Power  

This numeric input field defines the length of the time, in seconds, after which inactivity 
of the scanner, keyboard, or radio results in a power saving shutdown of the terminal. The 
default is 300 (5 minutes). 

Backlight  

This numeric input field defines the length of time, in seconds, during which the 
terminal’s display backlight remains on after keyboard or scanner input. When set to a 
value other than 0, the terminal turns on the backlight for the amount of time specified. 
Backlight use reduces battery life. The default value is 5. 
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Keepalive (3270/5250 only) 
This option group circumvents host application connection timeouts by automatically 
generating the selected keystroke when the terminal is inactive for the specified period of 
time, in minutes. 

Collection Timer (VT/HP only) 
This scrolling list option specifies the number of milliseconds the terminal waits for 
inactivity from the host before processing received data. This feature is useful in 
situations where the application and network latency fragments host transmissions to the 
terminal, and also when host applications generate intermediate displays that are not 
used. The default value is 100.  

Note: For maximum performance, adjust the collection time to 30-50ms when Mode on 
the Keyboard tab is set to char. 

Customizing Alarms 
Clicking on the Alarm tab shows the options related to the terminal alarm mechanisms, as 
shown below. 

 

Mode  
This scrolling list option defines the operation of the audible alarm and scanner light on 
the terminal. Default is bell.  
• = Off disables the audible alarm. 
• = Bell enables the audible alarm as a double beep. 
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• = Flash enables the scan indicator light as the alarm - no audible alarm sounds.  
• = Both enables the double beep and the scan indicator light as the alarm.  
• = Spec1 enables the audible alarm as a single beep.  
• = Spec2 enables a single beep and the scan indicator light as the alarm. 

Volume  
This scrolling list option set the volume of the audible alarm. The default is setting is hi. 

Duration & Frequency 
The next two options, duration and frequency, are used to make a distinction between 
alarms and scan decode tones when the Mode is set to spec1 or spec2. 

Duration  

This numeric entry field defines the length of the alarm sound in milliseconds. The 
default is 150. 

Frequency  

This numeric entry field defines the frequency of the audible alarm in Hertz. The default, 
zero (0) selects the terminal's factory-set default which is terminal model dependent. The 
default value is 2048. 

Allow Multiple  
This check box enables (checked), or disables (unchecked), multiple alarms in a single 
host transmission.  

Scan Duration & Frequency 
The next two options, scan duration and frequency, relate to the tones generated when the 
scan decoder successfully identifies a symbology. 

Scan Duration  

This numeric input field defines the duration of the tone generated by a successful scan 
decode, in milliseconds. The default is 300. 

Scan Frequency  

This numeric entry field defines the frequency of the scan decode tone in Hertz. The 
default, zero (0), selects the terminal's factory-set default which is terminal model 
dependent. 

By Attribute (3270 only) 
This scrolling list entry defines how 3270 field attributes can be used to generate alarms. 
The choices are off (the default), pen for the light pen attribute, num for numeric 
attribute, hi for high intensity attribute, and hal for high intensity and light pen attributes. 
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Protected  

This check box enables (checked), or disables (unchecked), the processing of the field 
attribute into audible alarms for all protected fields on the display. 

Unprotected  

This check box enables (checked), or disables (unchecked), the processing of the field 
attribute into audible alarms for all unprotected fields on the display. 

Alternate (5250 only) 
This check box enables (checked), or disables (unchecked), the conversion of a single 
digit character at a specified row and column on the 5250 display into the corresponding 
number of audible alarms. 

Row  

This numeric input field specifies the zero-based row number in the 5250 display of the 
alternate alarm digit. 

Column  

This numeric input field specifies the zero-based row number in the 5250 display of the 
alternate alarm digit. 
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Customizing Printers 
Clicking on the Printer tab shows the options related to the terminal printer, as shown 
below. 

 
 

Type  
This scrolling list option defines the type of printer attached to the terminal. The default 
is none. 

Init Object 
This feature allows printer initialization commands to be sent to the terminal immediately 
after the terminal establishes a session. This is an advanced integration tool and is 
described in Chapter 6. 

Flag Byte, Row, Column, and Clear Key (3270,5250 only) 
This group of options provides 3270 and 5250 host application direct control over the 
terminal printer. See the Start and End later in this section for an alternate method. 
VT/HP applications rely on standard escape sequences for the printing function. 
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Flag Byte 

This numeric input field is a decimal value that corresponds to the ASCII-converted 
value of an EBCDIC character generated by the host application. When the Flag Byte is 
set to a non-zero value, the terminal checks the host display for the value at the specified 
row and column (see Flag Row and Flag Column below). If the Flag Byte is present, all 
data in the display that follows the Flag Byte is routed directly to the printer, up to the 
next occurrence of a Flag Byte value in the display or else the end of the display. 

Flag Row  

This numeric input field specifies the row (zero-based, range of 0 to23) where the Flag 
Byte (defined above) is located. 

Flag Column  

This numeric input field specifies the column (zero-based, range of 0 to79) where the 
Flag Byte (defined above) is located. 

Clear Key  

This scrolling list option defines the keystroke transmitted by the terminal after printing 
has completed. Set the key to noop to disable transmission.  

Start and End (3270 and 5250 only) 
This option group provides the host application direct control over the terminal printer. 

Start 

Specifies a unique character sequence that, when encountered in the host display, 
indicates that all subsequent characters up to but not including the End character 
sequence are to be transmitted to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use.  

Note: The print data limit is 1.5 K. 

End  

Specifies a unique character sequence that terminates collection of data from the host 
display area for transmission to the printer attached to the terminal. The default value is 
blank which also indicates that this option is not in use. 

Start and End Convert (3270/5250 only) 
This option group provides for conversion of print data collected with the Start and End 
option group from ASCII characters in hexadecimal format (0-9 and A-F) to binary. The 
feature allows binary data that might otherwise interfere with the emulation to be 
included in the display area.  The host application is responsible for generating the 
hexadecimal data. 



  Customizing Printers 

Twin Client Reference   •     June, 2004    5-17

Start Convert  

Specifies a unique character sequence (ASCII-converted) within the print data collected 
with the Start and End options that indicates the subsequent character pairs are 
hexadecimal values that are converted to binary. A blank value, default, indicates that this 
option is not in use. 

End Convert  

Specifies a unique character sequence (ASCII-converted) that terminates binary 
conversion. Default, blank, indicates that this option is not in use. 

LXE Option (3270/5250 only) 
This check box enables (checked), or disables (unchecked) the processing of print data 
embedded in the datastream according to LXE printing rules. 

Convert Flag Byte and Conversion (3270 only) 
This option group defines the conversion of a single character (Convert Flag Byte) found 
in the 3270 print data, to a printer control sequence defined by the Conversion scroll list. 

Convert Flag Byte 

This numeric input field defines an ASCII value, in decimal, that will be converted to a 
printer control sequence as defined by the Conversion option. The default value is zero 
(0), which disables conversion. 

Conversion 

Specifies what the Flag Byte is converted to. The options are crnl, cr, and nl which 
represent ASCII carriage return new line, carriage return, and new line, respectively. The 
default value is crnl. 
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Miscellaneous Customizations 
Clicking on the Misc tab shows the following options window. 

 
 

Extended Command Group (3270 and 5250 only) 

This option group provides 3270 and 5250 host applications with the same extended 
command set available to VT/HP applications. Refer to Chapter 6 for a detailed 
description of the Extended Commands. 

Start  

Specifies a unique character sequence that, when encountered within the host display, 
indicates that all subsequent characters up to but not including the End sequence, are to 
be interpreted as an Extended Command. Default, blank, indicates that the option is not 
in use. 

End  

Specifies a unique character sequence that terminates the Extended Command. 

Data Stream Group (3270 only) 
Send All MDT  

This check box enables (checked), or disables (unchecked) the transmission of all fields 
with the MDT (Modified Data Tag) bit set. When disabled, only unprotected fields are 
transmitted. The default is enabled, which transmits all fields with the MDT set. 
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Send NULL  

This check box enables (checked), or disables (unchecked) the transmission of NULL 
characters to the host system. The default value is disabled. 

Note: For AS400 hosts, this option must be unchecked.  

Enable TN3270E 

If this box is checked, will negotiate using TN3270E rules (see RFC 2355). 
If this box is unchecked, will NOT negotiate TN3270E and will use IBM 3278 Mod 2. 

Answerback (VT/HP only) 
This text input field defines the response returned to the host application when the 
answerback command (as defined under VT/HP emulation) is received. If this value is 
left blank, the terminal automatically returns an ASCII string corresponding to the 
emulation in use (vt100, vt220, or hp700). 

Non-graphic characters may be embedded in the answerback field using the escape 
sequence  \nnn , where the backslash is followed by three digits representing the octal 
value. Refer to ASCII Character Set Octal Values in Chapter 9. 
 
$1 = terminal number. IP terminals = last two octets of the IP address.  
Spectrum One = 065-511 

Inserting the sequences “$A”, “$B”, “$C”, and “$D” into the answerback string results in 
a substitution of four octets, three octets, two octets, and the last octet of the terminal IP 
address, respectively, as shown below.  

$A - all four octets of the IP address (206.183.067.226) 
$B - the last 3 octets (183.067.226) 
$C - the last 2 octets (067.226, same as $1) 
$D - the last octet (226) 

Given a terminal with an IP address of 206.183.67.226, the following examples 
demonstrate how substitution and non-graphic escape sequences are processed.  
 
Answerback   Data Sent in Response to Answerback Command 
Hello World  Hello World 
$A   206.183.067.226 
RF$A   RF206.183.067.226 
RF$A\015  RF206.183.067.226<carriage return> 
$B   183.067.226 
RF$B   RF183.067.226 
RF$B\015  RF183.067.226<carriage return> 
$C   067.226 
RF$C   RF067.226 
RF$C\015  RF067.226<carriage return> 
$D   226 
RF$D   RF226 
RF$D\015  RF226<carriage return> 
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Chapter 6 • Advanced Integration 
This chapter describes the use of the advanced integration features built in to the Twin 
Client. These features make it possible to tailor Twin Client operation to meet special 
customer requirements without custom programming. 

Integration objects are used to implement the Twin Client advanced integration 
capability. An editor is used to create and modify each object, and the objects are 
associated with a terminal configuration using the Advanced setup options described in 
the previous chapter. The objects then become part of the terminal's software 
configuration and as a result are supported by the powerful Airloader Auto-Configuration 
tools described in Chapter 8. 

Clicking on the Object Editors menu of the Twin Client Manager displays the editor 
menu. 

 

The following sections describe the use of each object, how to create the object, and how 
to assign the object to a terminal configuration using the Advanced Setup options. 

A detailed description of the Extended Commands, which are used by applications to 
dynamically control the terminal scanner and keyboard, is included in this chapter. The 
advanced emulation-specific configuration options to which the previous chapter refers 
are also described here. 

Keyboard/Mapping  
The Keyboard/Mapping object is used to change the functionality of the terminal 
keyboard. This feature is most often used to simplify keyboard usage and reduce operator 
workload. It is also used to reduce re-training requirements when introducing new 
terminal models. 
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The need for keyboard mapping is a result of the size-restricted keypads common to all 
portable terminal devices. Compensating for the physical limitations, the manufacturer 
uses state modifier keys to expand the functionality of the keypad. As a result, many keys 
(e.g., the Up-Arrow key) require the operator to press two or more keys to emulate a 
single keystroke. Because many applications tend to rely heavily on a small group of 
keys, it is advantageous to map those frequently used keys to single key strokes, thus 
increasing both productivity and user acceptance. 

Creating the Object 
Create the object by clicking on Object Editors, then click on Keyboard/Mapping and 
select a terminal type. 

 

Click on the desired terminal model and click on OK, which starts the keyboard mapper 
for the selected terminal model. 
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The Keyboard Mapper screen provides a mock-up of a keypad on the left side of the 
window, and options for key remapping on the right. By clicking on a key on the keypad 
mock-up, the available options that apply to that key appear on the right. For example, 
clicking on the key at the lower right corner of this model changes the display as follows. 

 

The first column on the right side of the window, entitled Transmit, defines the 
emulation key assigned to the highlighted keypad button in each of the available 
keyboard states (unshifted, shifted, alpha lock, etc.). Each modified key state is initially 
blank, indicating that the Twin Client default is in effect and no changes will be made to 
that key or its Mode of operation. Refer to Chapter 10 for the table of default Twin Client 
key assignments for each Telxon terminal. 

 

After a key is selected, the Mode options change depending on the key selection. The 
Mode column defines the action taken by the selected key combination. 
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The table of mode options, and their effect, is as follows. 
 

xmit Transmits the key. 

noop Disables the key. 

edleft Non-destructive backspace (moves) to the left of the cursor within a field. 

edrite Non-destructive space (moves) to the right of the cursor within a field. 

edbksp Destructive backspace (moves) to the left of the cursor within a field. 

edeeof Erases from current position to end of field. 

edefld Erases entire field. 

lhelp Displays terminal ID, date, time, and terminal software version number. 

scan Activates the scanner. 

Saving and Assigning the Object 
Save the object by clicking on File, Save As, and then enter a name. For the purposes of 
this example, the name is vt.  

 

Then click on Save. Return to the Twin Client Manager menus by clicking on the  
button at the upper right corner of the Keyboard Mapper window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Keyboard tab, then on the Mapping 
Object list button, and finally on the object name. 
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Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the keyboard mapping will take effect. 

Keyboard Macros 
The Keyboard/Macro object is used to assign sequences of characters to the VT/HP 
programmable function keys. Using this feature, strings of characters can be assigned to a 
single keystroke.  

Creating the Object 
Create the object by clicking on Object Editors, then Keyboard/Macros, and then enter 
a file name. For the purposes of this example, the name is vt. 

 

Click on the Open button, and then click on the Yes button to create the new file. 

 

The Notepad utility is then invoked. The Keyboard/Macro object is a text file with one 
entry per line. Each entry uses the following format,  
<keyname>=<macro string>; 
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where <keyname> is pf1 to pf24, and <macro string> is the macro text assigned to that 
specific key. For example, to assign the text "vt100" followed by a carriage return to the 
pf9 key, the entry is: 

 
Note: \015 represents the octal value for “carriage return”. Refer to ASCII Character 

Set Octal Values in Chapter 9. 

Saving and Assigning the Object 
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Keyboard tab, then on the Macro 
Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the keyboard macro will take effect. 

Scanner/Data Mapping  
The Scanner/Data Mapping object defines barcode sequences that, when encountered in 
scanned data, are automatically converted to emulator keystrokes. This feature can be 
used to reduce or eliminate keyboard entry by the operator. That is, instead of pressing 
the PF3 key to access a help screen, the operator scans a barcode that is mapped to the 
keystroke. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner Data/Mapping, and then 
enter a file name. For the purposes of this example, the name is vt. 
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Click on the Open button, and then click on the Yes button to create the new file. 

 

The Notepad utility is then invoked. The Scanner/Data mapping object is a text file with 
one entry per line. Each entry uses the following format, 
<barcode>=<keystroke>; 

where <barcode> is the scanned barcode and <keystroke> is the keystroke to send when 
the barcode is scanned. The following example object demonstrates three scan data 
mappings, including the mapping of barcode $H to the PF3 keystroke.  

 

Note: The scan data mapper accepts octal notation. See the example below.
           # 
           # Sample scanner data mapping object 
           # 
           001253=pf4; 
           \011=tab; 
           \015=enter; 
           ENT=enter; 
           TB=tab;
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Saving and Assigning the Object 
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Data Mapping 
Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the scanner data mapping will take effect. 

Scanner/Data Editing  
The Scanner/Data Editing object defines the rules for recognizing barcode patterns, and 
then for performing automatic manipulations on the barcode before it is transmitted to the 
host application. This feature is most often employed when upgrading wedge-based 
systems. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner/Data Editing. 

 

 

Barcode recognition is based on the size (length) and recognition specifiers. Once the 
pattern is recognized, operation specifiers manipulate the barcode. 

The recognition specifiers consist of the four characters shown in the following table: 



  Scanner/Data Editing 

Twin Client Reference   •    June, 2004    6-9

 A Alpha character 
N Numeric character 
* Any character 
= Must match next character 

The operation specifiers consist of the following constructs: 
 X    Delete character 

*    Copy as is 
( )    Substitute 
““      Insert 

The following table illustrates how the recognition and operation specifiers identify and 
manipulate the data. 
 

Barcode Size Recognition Operation Result 

PN-1245 7 AA=-NNNN “F”******* FPN-1245 

5A5567BBAT 10 ********** **********”M” 5A5567BBATM 

TGR87 5 =T=GAN* **(S)** TGS87 

78-RHG 6 NN=-AAA **X*** 78RHG 

Saving and Assigning the Object 
Save the object by clicking on File, Save As, and then enter a name. For the purposes of 
this example, the name is vt.  

 

Then click on Save. Return to the Twin Client Manager menus by clicking on the  
button at the upper right corner of the Scan Editor window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Data Editor 
Object list button, and finally on the object name. 
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Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the scan data editor object will take effect. 

Scanner/Decoder Control 
The Scanner/Decoder Control object modifies the operation of the scan decoder in the 
terminal. Any of the supported symbologies can be enabled or disabled, and all of the 
parameters associated with a specific symbology can be modified to meet specific 
customer requirements. 

This feature is used primarily to reduce errors and increase performance. For example, a 
terminal used in a receiving application can be restricted to symbologies used only in the 
receiving department, thus reducing the opportunity for scan decoder errors and, in many 
cases, increasing scanner performance. As another example, the scan decoder can be 
instructed to return a successful scan only when the barcode is of a certain length. As a 
result, the opportunity for a scan decoder error is further reduced. 

Twin Client also allows the scanner to be controlled dynamically by the application. This 
is accomplished through the use of the Extended Command set, which is described later 
in this chapter. 

Creating the Object 
Create the object by clicking on Object Editors, then Scanner/Decoder Control. 
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The check box next to the symbology enables (checked) or disables (unchecked) the 
symbology. The options for a specific symbology are available for modification by 
highlighting the selected symbology. 

Saving and Assigning the Object 
Save the object by clicking on File, Save As, and then enter a name. For the purposes of 
this example, the name is vt.  

 

Then click on Save. Return to the Twin Client Manager menus by clicking on the  
button at the upper right corner of the Decoder Control window. 



Advanced Integration 

   Twin Client Reference    •   June, 2004 6-12

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Scanner tab, then on the Decoder 
Control Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the scan decoder control object will take effect. 

Display/Mapping 
The Display/Mapping object is used to correct variations between application character 
sets and the terminal display character set. The terminal display uses the ISO-8859-1 font 
set, which is an international standard adhered to by most, but not all, applications. The 
display mapping is used to resolve any discrepancies. 

Creating the Object 
Create the object by clicking on Object Editors, then Display/Mapping, and then enter a 
file name. For the purposes of this example, the name is vt. 

 

Click on the Open button, and then click on the Yes button to create the new file. 
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The Notepad utility is then invoked. The Display/Mapping object is a text file with one 
entry per line. Each entry uses the following format, 

<application char>=<ISO-8859-1 char>,xlat; 

where <application char> is the hexadecimal value of the character transmitted by the 
host application, and <ISO-8859-1 char> is the hexadecimal value of the desired 
terminal display character, followed by a comma, the word xlat, and a semicolon. Tables 
for both ISO-8859-1 and the ASCII character sets are in Chapter 9.

For the purposes of this example, the English character e (0x65) will be converted to an 
umlaut ë (0xEB) with the entry shown below. Note that that the two character 
hexadecimal values must be preceded by 0x. 

 

Saving and Assigning the Object 
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Display tab, then on the Mapping 
Object list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the display mapping object will take effect. 

Display/Formatting 
The Display/Formatting object is used to make the host application interface easier to 
use, without modifying the host application. Chapter 7 is devoted to the description of 
this important integration feature. 



Advanced Integration 

   Twin Client Reference    •   June, 2004 6-14

Printer/Init 
The Printer/Init object is used to send initialization commands to the printer at the start of 
each terminal session. It can also be used to test printer operation. 

Creating the Object 
Create the object by clicking on Object Editors, then Printer/Init, and then enter a file 
name. For the purposes of this example, the name is vt. 

 

Click on the Open button, and then click on the Yes button to create the new file. 

 
The Notepad utility is then invoked. The printer/init object is a text file, allowing for the 
entry of printer-specific commands. Refer to the documentation provided by the printer 
manufacturer for instructions.

Saving and Assigning the Object 
Save the object by clicking on File, then on Save, and then on Exit, which returns to the 
Twin Client Manager menu. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Printer tab, then on the Init Object list 
button, and finally on the object name. 
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Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the init object will be transmitted to the printer at the start of the next Telnet session. 

Dialog 
The Dialog object is a script used to automate difficult or repetitive user interactions with 
the host application. It can be used to create terminal screens, collect input, generate 
output, and make decisions based upon terminal keyboard or scanner input, and host 
application data. 

Creating the Object 
Create the object by clicking on Object Editors, then Dialog. Commands selected from 
scrolling list on the right are added or inserted into the scripting area on the left using the 
click buttons between the two areas. The bottom left portion of the window is used to 
collect arguments for those commands that require them. 

 

Commands and Arguments  

Commands control the actions taken within the script. They can be used to interact both 
with the host and the terminal, and to modify activity based on comparisons of both 
terminal and host data. The following tables describe each command. 
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Label Defines a target for the conditional branch commands Onfail, 
Equal, If, Host State, Host Scan, and the unconditional 
branch command, Goto. 

Goto Causes execution to begin unconditionally and immediately 
at the named target Label. 

On Fail Upon detection of a system error, execution continues at the 
named Label. 

Equals If the comparison is equal, branches to Label. Otherwise, 
execution continues with the next command. 

If If the conditions of the comparison operator are true, 
branches to Label. Otherwise, execution continues with the 
next command. The numeric value comparison operators, 
which treat the values being compared numerically, are = 
(equal). != (not equal), > (greater than), and < (less than). 
The string value comparison operators, which treat the values 
as character strings, are $= (equal) and $!= (not equal) 

Set Var Assigns a value to one of up to 36 variables. 

Change Var Adds to or subtracts from the value of a variable. 

Concat Adds characters to the end of a variable. 

Session Returns control of the session to the terminal operator. The 
operator returns control to the dialog object, at the next line, 
by pressing the key defined as the End Key in the Keyboard 
tab. 

Host On Initiates a TCP/IP connection to the host system. 

Host Off Terminates the TCP/IP connection to the host system. 

Host Scan Scans the host display for a value, and continues execution 
at the named label if the value is found. 

Host Update Refreshes the host display. This command is used after data 
has been sent to the host that may change the display, and 
prior to using the Host Scan or Host State conditional 
branch commands, or a Host Copy command. 

Host Send Transmits data and/or a keystroke to the host. 

Host Copy Copies characters from the host display to a variable. 

Host State If the state of the session matches the value supplied, 
execution begins at the named Label. The possible values 
are inactive, meaning the host session has not been 
established, and plu, which means the host session has 
been established. 

Settle Allows time for the host application to settle. 

Term Enable Initializes the terminal configuration parameters. 

Term Clear Clears the terminal display of all characters. 

Term Display Puts a value or the value of a variable on the terminal display.



  Dialog 

Twin Client Reference   •    June, 2004    6-17

Term input Prompts the terminal operator to input data. 

Term No Echo Prompts the terminal operator to input data, which will not be 
echoed on the terminal display. 

Term Wait Waits for any input from the terminal. 

Term Logoff Terminates the connection to the wireless network. 

Exit Terminates execution of the dialog object. 

Sleep Suspends all activity for the specified number of seconds. 

Var Char Sets the character used internally by the dialog processor to 
indicate the name of a variable. The character is normaLoglly 
$. This command is used only when the first character of a 
value used in one of the conditional branching commands 
begins with a $. 

Log Writes a message to the terminal log. 

Comment Inserts documentation in the dialog object. 

Adding Commands 

The scrolling list box on the right side of the window is used to select a command. Click 
on the desired command and then click on the Add button to add the command to the 
dialog script. 
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All commands that require arguments prompt for them in the box at the lower left side of 
the window. In the example above, the Term Display command requires a row number 
and either a variable or a character string. In this case the display string is Hello World. 
Note that the text entry field scrolls to the right so that text longer than the size of the box 
can be entered. 

Inserting and Deleting Commands 

Click on the desired dialog line on the upper left side of the window to highlight the line, 
then click on the Insert button to insert a new command above the selected line, or click 
on the Delete button to remove the line. 

Using Variables and Labels 

The dialog object provides up to 36 variables to store temporary data collected during the 
execution of the script.  

 

These variables can be compared to fixed values or other variables using the if command. 
If the comparison is true, execution branches to the specified label. 

 



  Extended Commands 

Twin Client Reference   •    June, 2004    6-19

Saving and Assigning the Object 
Save the object by clicking on File, Save As, and then enter a name. For the purposes of 
this example, the name is vt.  

 

Then click on Save. Return to the Twin Client Manager menus by clicking on the  
button at the upper right corner of the Decoder Control window. 

Next, assign the object to a terminal configuration by opening a terminal configuration 
from the File menu. Click on the advanced setup Display tab, then on the Dialog Object 
list button, and finally on the object name. 

 

Save the updated terminal configuration by clicking on File, and then Save. The next 
time the terminal is cold-booted, the new configuration will be downloaded automatically 
and the dialog object will take effect. 

Extended Commands 
The host application can control the terminal's scanner and keyboard dynamically, while 
the terminal is in session, by issuing the extended commands described in the following 
sections.  

Dynamic Decoder Control 
The format and content of the commands that control the scan decoder are described in 
the following sub-sections. 

CODABAR Control 

Extended Command: 
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<ESC>[?0;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable codabar scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values are 1–54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are 1–54. 

CODE 128 

Extended Command: 

<ESC>[?2;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable code 128 scanning. 0=disabled, 1=enabled. 
• = Minlen: Specify minimum valid barcode length. Valid values are from 1 to 54. 
• = Maxlen: Specifies the maximum valid barcode length. The maximum length must 

be greater than or equal to the minimum length. Valid values are from 1 to 54. 

CODE 39 

Extended Command: 

<ESC>[?3;<state>;<minlen>;<maxlen>;<depend>z 
• = State: Disable/enable code 39 scanning. 0=disabled, 1=enabled. 
• = Minlen: Specifies the minimum valid barcode length. Valid values are from  

1 to 54. 
• = Maxlen: Specifies the maximum valid barcode length. The maximum length must 

be greater than or equal to the minimum length. Valid values are from 1 to 54. 
• = Depend: Disable/enable full ASCII code 39 interpretation. 0=disabled, 1=enabled. 

INTERLEAVED 2 OF 5 

Extended Command: 

<ESC>[?7;<state>;<minlen>;<maxlen>;0z 
• = State: Disable/enable interleaved 2 of 5 scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values range from 1 to 54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values range from 1–54. 

EAN-8/13 

Extended Command: 

<ESC>[?9;<state>;0;0;0z 
• = State: Disable/enable EAN-8/13 scanning. 0=disabled, 1=enabled. 

PLESSEY/MSI 

Extended Command: 

<ESC>[?10;<state>;<minlen>;<maxlen>;<depend>z 
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• = State: Disable/enable code MSI scanning. 0=disabled, 1=enabled. 
• = Minlen: Minimum valid barcode length. Valid values are from 4 to 54. 
• = Maxlen: Maximum valid barcode length. The maximum length must be greater 

than or equal to the minimum length. Valid values are from 4 to 54. 
• = Depend: Specifies the number of required check digits. Valid values are 0, 1, or 2. 

UPC-A/E 

Extended Command: 

<ESC>[?13;<state>;0;0;0z 
• = State: Disable/enable UPC-A/E scanning. 0=disabled, 1=enabled. 

Supplemental Barcode Handling (UPC/EAN) Options 

Extended Command: 

<ESC>[?12;<state>;<minlen>;<maxlen>;<depend>z 
• = State: This flag should always be set to one. 
• = Minlen: Specifies if two character supplementals are enabled/disabled (only 

applies to transmit mode 1). 0=no codes with two character supplementals decoded, 
1=codes with two character supplementals decoded. 

• = Maxlen: Indicates if five character supplementals are enabled/disabled (only 
applies to transmit mode 1). 0=no codes with five character supplementals decoded, 
1=codes with five character supplementals decoded. 

• = Depend: Specifies the supplemental transmit mode. 0=no supplementals 
transmitted to host, supplemental enable/disable ignored. 1=only codes with the 
appropriate supplemental (from minlen/maxlen) decoded. 2=all codes sent as is, 
supplemental enable/disable ignored. 

Disabling All Decoders 

Extended Command: 

<ESC>[?z 

This command is used to disable all barcodes on the handheld. Typically this would be 
issued before turning on an individual barcode type just to make sure of the state of the 
active barcodes. 

Input Mode Command 
The input mode parameter sent from the application controls (via the host application) 
whether the terminal accepts input from the keyboard, the scanner or both. The format of 
this command is as follows: 

<ESC>[!1;<mode>z  

The mode parameter can be one of the following: 
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Mode Action Description 

0 (default) Scan and Key Data initially accepted from either the keyboard 
or scanner. Scanning, allowed on a partially 
keyed field, causes the keyed data to be 
discarded and the scanned data to be accepted. 

1 Scan or Key Data initially accepted from either the keyboard 
or scanner. Scanning is not allowed on a 
partially keyed field. If the operator clears the 
field then scanning is again allowed.  

2 Scan Only Data accepted only from the scanner. Use 
caution when using this command, bad barcode 
can block the user from completing input. 

3 Key Only Data accepted only from keyboard, the scanner 
off. 

Key Input Mode Command 
The processing of keyed input can be controlled dynamically, while the terminal is in 
session. The format of this command is as follows: 

<ESC>[!2;<mode>z  

The mode parameter can be one of the following. 
 
Mode Description 

0 (default) Accepts characters between 0x20 and 0x7F. 

1 Accepts alphabetic characters only. 

2 Accepts numeric characters only. 

3 Accepts alphanumeric characters only. 

For example, to allow keyboard input of numeric characters only, use the following 
sequence: 
 <ESC>[!1;3z<ESC>[!2;2z 
(HEX equivalent: 1B 5B 21 31 3B 33 7A 27 5B 21 32 3B 32 7A) 

To reset the terminal back to normal input, use the following sequence: 
 <ESC>[!1;0z<ESC>[!2;0z 
(HEX equivalent: 1B 5B 21 31 3B 30 7A 27 5B 21 32 3B 30 7A) 

Dynamic Font Change 
 

Where DoubleHigh and DoubleWide can each be either 0 or 1:  
<ESC>[!5;<DoubleHigh>;<DoubleWide>;z  
 
To set only Double High mode: <ESC>[!5;1;0;z  
 
To set only Double Wide mode: <ESC>[!5;0;1;z  
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To set Double High, Double Wide mode: <ESC>[!5;1;1;z  
 
To restore normal fonts: <ESC>[!5;0;0;z 

Advanced Display Options for VT/HP 
The Advanced button in the advanced view Display tab is active when VT100, VT220, 
or HP700 emulation is selected. This option group controls how display attributes are 
processed, and it can also be used to simulate block mode operation (see the Mode option 
description in the Chapter 5 section, Customizing the Keyboard). 

 

Attribute Mask 

This check box group enables (checked), or disables (unchecked), the display of the 
indicated character attribute. The character-based terminal displays are capable of 
displaying only the Reverse and Blinking attributes. All other attributes, if enabled, are 
displayed in Reverse, except for those attributes checked in the Blink Mask group  
(see below).  

Field Mask 

The VT100 and VT220 protocols do not support the more efficient block mode of 
operation that is standard in the 3270 and 5250 protocols, since there are no VT100 or 
VT220 protocol commands for defining input fields. 

However, Twin Client makes it possible to simulate block mode operation by using video 
display attributes to define input fields. Each box checked in the Field Mask window 
indicates a video attribute that will be recognized as an input field specification by the 
emulator. During a terminal session with a host, whenever the cursor is positioned on 
character with the selected attribute(s), all characters to the right of that position with the 
same attribute are interpreted to specify the length of the input field. 

Blink Mask 

This check box group is used to enable (checked), or disable (unchecked), the conversion 
of the selected attribute to Blinking. 
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Advanced 3270 Keyboard Options 
The Advanced button in the advanced view Keyboard tab is active when 3270 
emulation is selected. The option groups in this window are used to automate keystroke 
generation under the special conditions described in the following subsections. It is also 
used determine the action taken with oversized scans. 

 

Attribute Key 
This option is used to automatically transmit a keystroke to the 3270 host when the 3270 
field matches the selected attribute. The automatic keystroke generation can be based on 
whether the input is scanned, or keyed, or both.  

Note: When this feature is made active (setting the Key to a value other than noop and 
setting the Scan Field and or Key Field to a value other than off) it overrides all 
other automatic keystroke generation rules except for the Last Field Keys rules 
(described later in this section). 

Key 

This scrolling list box is used to select the 3270 keystroke sent with scanned or keyed 
input when the field matches the selected attribute setting specified in Scan Field and 
Key Field (described below). This option overrides all other automatic keystroke 
generation, except for Last Field processing. The default key setting of noop disables this 
function. 

Scan Field 

This scrolling list box selects the 3270 field attribute that, when data is scanned into the 
field, results in automatic transmission of the selected Key with the data to the host. The 
choices are pen (for 3270 Light Pen Enabled), num (for 3270 Numeric Only), hi  
(for 3270 High Intensity) and hal (for 3270 High Intensity and Light Pen Enabled). The 
default value is off. 
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Key Field  

This scrolling list box selects the 3270 field attribute that, when data is keyed into the 
field and the field is completely filled, results in automatic transmission of the selected 
Key with the data to the host. The choices are pen (for 3270 Light Pen Enabled), num 
(for 3270 Numeric Only), hi (for 3270 High Intensity) and hal (for 3270 High Intensity 
and Light Pen Enabled). The default value is off. 

Last Field Keys 
This option is used to automate keystroke generation when the keyed or scanned input is 
into the last field on the 3270 display. 

Note: When this rule generates a keystroke, it overrides all other automatic keystroke 
generation rules (i.e., Scan Key, Auto Send Key, and Attribute Key). 

Scanned Input  

This scrolling list box is used to select the 3270 keystroke to be sent when data is scanned 
into the last field on the 3270 display. The default value is noop, which disables this 
function.  

Keyed Input 

This scrolling list box is used to select the 3270 keystroke to be sent when data is keyed 
into the last field on the 3270 display, and the field is filled. The default value is noop, 
which disables this function. 

Multiple Fields  

This check box enables (checked) the Last Field Keys group only if the host display 
contains more than one input field. 

Key Wrap 
This check box enables (checked), or disables (unchecked) the automatic wrapping of 
oversized scanned input to subsequent 3270 input fields. 

Note: This option has no effect if either Length Checking or Truncation options are 
enabled (see Chapter 5, Customizing the Scanner). 
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New Environ Telnet Extension 
The New Environ Telnet extension, also known as Workstation ID, is a mechanism for 
providing named variables with values to the host system via a Telnet negotiation at the 
beginning of each terminal session. 

The New Environ option under the Twin Client Manager's Settings menu is used to 
create the variables, which are applied to all terminal configurations. Variables can be 
created that apply only to specific terminals (indicated by IP address). It is also possible 
to create variables that apply to all terminals. 

 

Creating Common Settings 
Variables that apply to all terminal sessions are created by clicking on the Common to 
all terminals button, and then entering the Variable and Value in the respective boxes. 
Then click on the Set button. 
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The variable and its value are then displayed in bottom list window.   

Creating Terminal Specific Settings 
Variables that apply to specific terminal sessions are created by clicking on the Terminal 
Specific button, and entering the last two octets of the terminal IP address. Then enter 
the Variable and Value in the respective boxes and click on the Set button. 

 

Note: Click on the Show all settings check box to display both terminal specific and 
common variables. 
 

When you set up the IP address in the New Environment entry form, you can get an 
“Invalid terminal address” error message. This error is from a routine that checks the IP 
address for accuracy. In IP settings, it is possible to use octal notation rather than the 
more common decimal method we see most often.  
 
The rule is that if there is a leading zero, it assumes octal notation and checks for a valid 
octal value (legal octal values are 0-7). For example if the second half of your terminal IP 
address is 078.131, the 8 in the .078 is what causes the error. The terminal client needs 
the leading zero(s) to correctly find the IP address. This leads to a catch 22.  

 
Note: The following work-around will require that you hand edit the configuration file to 

add the leading zeros if required. 
 
1. Enter the address as normal without any leading zeros. If they are all 3-digit octets, you 

need do nothing. If any octet is less than 3 digits, do the next step. 
 
2. Open the PowerNet\TwinClient\tnenv.cf file for edit. Add leading zeros to entries: 

 
78.132:DEVNAME=RF001;!    →    078.132:DEVNAME=RF001;! 
1.133:DEVNAME=RF002;!      →    001.133:DEVNAME=RF002;! 
12.134:DEVNAME=RF003;!    →    012.134:DEVNAME=RF003;! 
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Save and send this to the terminal by doing a "Terminal/Send Configuration Files to 
Terminal" operation. 

Changing and Deleting Settings 
Variable names and their values can be modified or deleted by clicking on the variable in 
the list window. Change the variable or value by editing the Variable and/or Value 
boxes, and click on the Set button. To delete the variable, press the Delete key on the PC. 
Deleted variables will continue to appear in the pull down list until after the settings have 
been saved. 

Saving New Environ 
Click on the OK button to save the New Environ settings.  

TN3270E Negotiation 
The following defines the TN3270E negotiation, permitting the transfer of some of the 
TN3270E Sub-negotiation variables such as Lunames from the Telnet terminal to the 
host during session initialization. 

Note: This pertains to 3270 emulation. 

TN3270E is implemented on OpenAir Linux using two text files located in the working 
directory (refer to /etc/.CRF/WORKDIR). The tnenvcom.cf file allows for the definition 
of variables that will be shared by all devices, and the tnenv.cf file allows for the 
definition of terminal-specific variables. These files are currently created and maintained 
with the system editor. 
 
Line Entry Format, tnenvcom.cf: 

VARIABLE=VALUE; 

Example *DEVTYP=IBM-3278-2;*CONNECT=RFZ81; 

This will assign all terminals the luname of RFZ81. 
 
Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semi-
colons. The entry is terminated with an exclamation. 

Example file: 

#IP terminals fully qualified octets 7 characters: 

010.031:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.001;! 

010.032:*DEVTYPE=IBM-3278-2;*CONNECT=RF3278.002;! 
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This will assign the terminal with an IP address of xxx.yyy.010.031 a device type of 
IBM-3278-2 to the luname of RF3278.001. 

New Environ Negotiation 
The following defines the New Environ negotiation, permitting the transfer of 
environmental variables from the Telnet terminal to the host during session initialization. 

Note: This pertains to the 5250 and VT emulations. 

New Environ is implemented on OpenAir Linux using two text files located in the 
working directory (refer to /etc/.CRF/WORKDIR). The tnenvcom.cf file allows for the 
definition of variables that will be shared by all devices, and the tnenv.cf file allows for 
the definition of terminal-specific variables. These files are currently created and 
maintained with the system editor. 

Line Entry Format, tnenvcom.cf: 

VARIABLE=VALUE; 

Line Entry format, tnenv.cf: 

IDENT:VARIABLE=VALUE;[VARIABLE=VALUE]…! 

Where IDENT is either the last two octets of the terminal's IP address, or the three digit 
Spectrum address (065-511). Multiple variables can be defined, separated by semi-
colons. The entry is terminated with an exclamation. 

Example file: 

#IP terminals fully qualified octets 7 characters: 

010.031:DEVNAME=RF5291.001;! 

#Spectrum ONE fully qualified radio ID 3 characters 

065:DEVNAME=RF5291.002;! 
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Chapter 7 • The Display Formatter 
The display formatter adapts full screen Telnet applications to the portable terminal 
environment without any modification to the host application. This powerful tool is 
included with Twin Client, and is also used with the OpenAir server when the Twin 
Client is operating the server-based "Server" mode. 

A screen capture utility (included with the Twin Client Manager) is used to access the 
host application via Telnet and "capture" the host displays. Once captured, the screens are 
processed into a screen formatter object and assigned to a terminal configuration, which 
can then be downloaded automatically to the terminal, over the wireless network. 

The Twin Client Display Formatter provides the following unique features: 
• = Performance - Optimized for minimum run-time overhead and maximum speed. 
• = Transparency - Fully transparent to the host application. 
• = Capacity - Up to 128 host screens per object, 16 terminal screens per host screen, 

and 32 input fields per terminal screen. 
• = Simplicity - Intuitive drag-and-drop interface for screen capture and formatting. 
• = Flexibility - Supports all Twin Client terminals. 

This chapter describes how to set the emulation, capture the host application displays, 
and process them into formatter objects for download to the terminal. 

Setting the Emulation 
The first step in the formatting process is to set the emulation (VT/HP, 3270, or 5250) in 
preparation for capturing the host application displays. Click on under Start, Programs, 
PowerNet, Twin Client Manager, and then the Settings menu, as shown below. 

 

Click on Emulation and select an emulator from the list below. 
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Then click on OK to return to the main Twin Client menu. 

Starting the Emulator 
Start the emulator by clicking on the Object Editors menu and Screen Capture, as 
shown below. 

 

The emulation window is displayed. Click on the Session menu, and then click on 
Session Settings. 

 

In the Session Settings menu, enter the Host IP address, port of the host system, and 
select the appropriate emulation from the drop-down menu. Click on OK to return to the 
emulator main menu. 
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Note: The Host Port of 23 is standard for Telnet. However, for security reasons the port 
number may be set to other values. Consult the local network administrator if a 
connection cannot be established on port 23. 

 

Note: In vt emulation, the Twin Client screen above contains a scroll bar to select 
          vt100, vt220, or hp700 emulation. 

To start a telnet session with the host, click on the  toolbar icon, or click on the 
Session menu and then on Connect. In this example, the 5250 emulator is used and the 
host system is an IBM AS/400. 

 

 

The host application displays are now ready to be captured. 
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Taking Snapshots 
The host screens are captured by clicking on the  toolbar icon while the desired 
screen is displayed. Alternately, click on Session and then Snapshot. The following 
pop-up indicates that the screen was captured. 

 

Click on OK and continue to navigate the host application, taking snapshots of the 
screens to be formatted. 

Saving the Screen File 

Save the snapshots at any time by clicking on the  toolbar icon. Alternately, click on 
File and then Save As. The following window is displayed for entering the filename. 

 

For this example, the filename is set to Untitled. Then click on the Save button to return 
to the emulator.  

Exiting the Emulator 

The telnet session is ended by clicking on the  toolbar icon, or by clicking on 
Session and Disconnect. Return to the Twin Client Manager window to format the 
screens by clicking on the  icon at the top right corner of the emulator, or by clicking 
on File and Exit. 
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Formatting 
The screen file created in the previous sections can now be formatted. This section 
describes how to start the formatter, open a screen file, format the screens, save the 
formatted object, and finally to assign it to a configuration. 

Starting the Formatter 
The formatter is started from the Twin Client Manager menu. Start the Twin Client 
Manager by clicking on Start, Programs, PowerNet, and Twin Client Manager. Then 
click on Object Editors, as shown below. 

 

Click on the Display/Formatting option and the formatter window is displayed. To open 
the screen file, click on File. 

 

Then click on Open, and click on the screen filename. 
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Then click on the Open button and the formatter window is displayed, including the first 
host display that was captured. The terminal display window, which is blank at this time 
since no formatting has taken place, is also shown. 

Note: The Terminal display window floats on top of the host screen. If it needs to be 
moved, click on the title bar and drag it to a different area of the host screen. 

 

Setting Up the Formatter 
The terminal display must be set to match the terminal for which the formatter object is to 
be created. Click on the Tools menu and then Setup.  



  Formatting 

Twin Client Reference   •    June, 2004    7-7

 

Click on the desired terminal display size, and also ensure that the host screen size is set 
correctly. Then click on OK to return to the formatter. 

Note: If, while reformatting host screens, you are able to create display fields larger than 
the selected screen size causing the reformatted screen not to appear on the 
terminal; Delete the terminal screen in question and reformat it, paying attention to 
the width of the RF terminal screen. 

Copying an Input Field 
An input field is copied from the host display to the terminal display by the same method 
used to copy text. Click the left side of the input field and drag the cursor to the right. The 
input field will be highlighted. Now click on the field again and drag it to the desired 
position in the Terminal display. 

Adding an Input Field 
To add an input field, create text in the screen formatter window, highlight it, and choose 
Add Input Field from the Host menu. The input field added in the example below is a 
lower-case letter “x”. 
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Adding and Copying Variable Display Text 
Variable text can be added to the terminal display by clicking on the Terminal window, 
moving the cursor to the desired display position, and typing in the text (in this case, 
variable text) as shown below. 

To do this, move the cursor to the desired position in the host display and hold down the 
mouse button while moving the cursor to the right. Then, right-click on the text to be 
copied. This text will be highlighted as shown by the words “variable text” copied 
below. Then drag the highlighted text to the desired position in the terminal display and 
release the mouse button. 
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Deleting a Field 
Select the text to be deleted by highlighting it, and choose Delete Field from the Host 
menu. 

 

Finding a Field on the Terminal 
To find a field on the terminal, choose Find Field on Terminal from the Host menu. 
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Adding an Ident 
Formatting requires each host screen to be uniquely identified. One way to do this is to 
highlight unique text on the host screen (click on the left side of the text and drag the 
mouse to the right). Then click on the right mouse button, as shown below. 

 

From the pull down menu, click on Add Ident. The highlighted field is now colored red 
on the host display, indicating that it is an Ident field. Up to 32 items can be highlighted 
on each host screen, so if a number of screens share similar features, they can be uniquely 
identified by adding more Idents. In the event that a group of host displays differ only by 
position of input fields, input fields can be used for Idents also. 

Removing an Ident 
Remove an Ident field by highlighting it, and then selecting Remove Ident from the Host 
menu. 
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Navigating the Screen Formatter 
To move to the first screen in the screen formatter, choose First Screen from the Host 
menu. 

 

To move to the next screen, select Next Screen from the Host menu. 
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To move to the previous screen, select Previous Screen from the Host menu. 

 

To move to the last screen, select Last Screen from the Host menu. 
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Adding a Terminal Screen 
New terminal screens are created by using the New button at the bottom of the Terminal 
display window. This is useful when more that one terminal screen is required to format 
the relevant data on the host screen. Up to 16 terminal displays can be associated with 
each formatted host display. These are called terminal pages, and the page that is 
displayed on the terminal at any point in time depends on the location of the host cursor 
position. The page to which the corresponding input field is formatted is the one 
displayed. 

 

When multiple pages are present, the directional arrows are used to navigate through the 
pages. 

Deleting a Screen 
To delete a screen, select Delete Screen from the Host menu. 
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Saving the Formatter Object 
The formatter object is saved by clicking on the  toolbar icon, or by clicking on File 
and Save.  

Assigning the Object to a Terminal Configuration 
The formatter object is assigned to a terminal configuration by opening a terminal 
configuration in the Twin Client Manager, assigning the object to the Display Formatting 
Object, and saving the configuration.  

To open a terminal configuration, click on File in the Twin Client Manager, as shown 
below. 

 

Then click on Open, and click on the desired terminal configuration. 
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Then click on the advanced view Display tab, pull down the Display Formatter Object 
scrolling list box, and click on the object. 

 

Save the newly modified terminal configuration using the  toolbar icon, or click on 
File and then Save. The new configuration, incorporating the formatter object, is updated 
on the terminal, automatically, by cold booting the terminal. 
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Chapter 8 • Software Management 
In addition to providing functions for the download of files to the terminal via the 
traditional serial connection, the Twin Client Manager also provides for the management 
of terminal software and configurations automatically, over the wireless network. 

This chapter describes the automated capability in detail. Additional manual operations 
involving serial download options are described at the end of this chapter. 

Airloader Auto-Configuration 
The software and supporting configuration files for all Twin Client terminals can be 
configured for automated management after installing the Twin Client AirLoad ARC file 
in the terminals, as described in chapter 3. The Airloader Auto-Configuration form is 
accessed from the Twin Client Manager Tools menu. Select Airloader. 

 
Note: If no options are displayed, click the Advanced<< button. 

Enabling Automatic Downloads 
Click to put a check in the Allow terminals to be automatically configured via RF box to 
enable automatic downloading. In the event another PC on the network is already 
configured and active, the following warning message is displayed. 
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Synchronizing Configuration Files 
Click to put a check in the Synchronize Configuration Files box to enable automatic 
synchronization of configuration files on the terminal. When the terminal is warm booted, 
its configuration files will be compared with the most recent on the PC. The terminal is 
updated automatically if it does not have the latest revision. 

Synchronizing Program Files 
Click to put a check in the Synchronize Program Files box to enable automatic 
synchronization of program files on the terminal. When the terminal is warm booted, its 
program files will be compared with the most recent on the PC. The terminal is updated 
automatically if it does not have the latest revision. 

Automatic IP Address Assignment 
New terminals will be assigned IP addresses automatically if the following box is 
checked. 

 
Note:    Do not check this option if a DHCP server is configured to manage address 

assignments. 

To set the addresses, click on the Addresses button to access the Segment Address 
Assignments dialog box, as shown in the following figure. 
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Enter the desired range in the From and To boxes as shown above, and click on Add. 

Creating New Groups 
Click on Terminal Group Manager, right click the mouse button, click on New Group.  

 

Click on Browse, to find the appropriate configuration file. In the Auto-Group box, 
check the item to be changed. Click on the pull-down menu for options. 
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Click on the Active check box after the configuration file and all of the other parameters 
have been set.  
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Clicking on the Thin Mode button will cause all terminals in this group that are currently 
running in thick mode to be switched to thin mode the next time Airloader is run on the 
terminal. 
 
Click on the Schedule button to view a dialog box for scheduling an automatic Airloader 
update. 

 

 
 

Select the desired time and click on OK. Click on Update Now to check all group 
members for updates. 
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Setting the Segment 

The Segment button restricts a terminal group to a range of IP addresses. The IP Address 
can be any valid address on the segment as it is used only to identify the segment. The 
setting of the Net Mask can be used to restrict the range.  This feature is useful for 
segregating terminal groups by location. 

Setting Force Reload 

The Force Reload button forces all terminals within a group to be automatically updated. 
The following warning message appears. 

 

Click on the Yes button to force the reload. 

Setting the Default Terminal Group 
New terminals that have not yet been assigned to any group are initially assigned to the 
default group in effect when they are cold-booted. 

 

Any group can be made the default group by clicking on the group, and then clicking on 
the right mouse button. Then click on the Make Default option. 

Reassigning Terminals 
After a terminal has been configured and assigned to the default group, it can be 
reassigned to a new group by clicking on the terminal icon as shown below. 

 

Then, holding the mouse button down, drag the terminal icon to the desired group as 
shown next. 
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Release the mouse button, which reassigns the terminal. 

 

The next time the terminal is rebooted, it will be reconfigured as defined in the group 
specification. 

TN Plus Features 
 
Under Tools in Twin Client Manager are the Screen Watcher, Terminal Messenger, 
and RF Monitor features. 

Note: The terminal may or may not be able to utilize the Screen Watcher or Terminal 
Messenger features depending on its authorization codes.  
 

 

Select Screen Watcher, enter the terminal’s IP address, and click on OK. 
 

 
 

A screen will appear with a display resembling the terminal screen. 
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Clicking on the Font button on the upper left brings up a screen in which you can modify 
the font settings, as shown below. 

 

 
 
Select Terminal Messenger from the Tools menu.  
 
You may enter an Address Range in the From and To boxes on this screen. Click on Add 
when finished. 
 
Enter a message to send in the space provided, select the terminal to receive this message 
by clicking on it in the Select Terminal(s) column, and click on the Send button to send 
the message of your choice to the terminal of your choice. 
 
See the example of the Terminal Messenger screen below. 
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To remove a terminal from the list of terminals receiving your message, click on the 
terminal number in the Select Terminal(s) column, and click on the Remove button. 
Click on the appropriate button, Remove All, Select All, or Unselect All, to remove all 
terminals, select all terminals, or unselect all terminals from the Select Terminal(s) list. 
 
Note: Use the Ctrl and Shift keys to select multiple terminals. 
 
Click on the Close button when finished. 
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Select RF Monitor from the Tools menu. 
 

 
 

RF Monitor is an "Over The Air" diagnostic tool. It's used to collect diagnostic trace 
information from RF terminals running PowerNet Twin Client software. 

It runs on a Windows PC and will send a command to the RF terminal to start tracing. 
The terminal, when it receives this command, will start sending the trace information 
over the RF link to the PC that issued the command. This will be written to a file on this 
PC that can be sent to us for analysis. 

Click on File to Select Terminal or to Exit. 

 

Choosing Select Terminal allows you to view a log of the terminal’s activity. Enter the 
Terminal IP address and Terminal IP Port, and click on OK.  
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Click on Edit. Select Find, and/or Find Next to search for pieces of information in your 
log, or select Clear to clear the search. 

 

Click on Actions to Start the Monitor or Stop the Monitor. 

 

Click on Tools to set Debug Levels or Settings. 

 

The options in Debug Levels are shown below. 
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The maximum log file size can be set under Settings. 

 

Click on View to show or hide the Toolbar and the Status Bar.  

 

This is the Toolbar. It is found near the top of the screen. 

 

This is the Status Bar. It is found at the bottom of the screen. 

 

Click on Help to bring up the following screen. 
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RF Monitor is a very small program and does not even require installation. Just place it in 
a directory on your PC and create a shortcut to run it. It will run on all versions of 
Windows except V3.1 and Win 95.  

 
1. Move RF MONITOR to a Win PC with Network access to the RF terminal. 

 
2. Run RF MONITOR (create a shortcut or do a start/run). 

 
3. From the pull down menus, select "File/Select Terminal". 

 
4. Key in the RF terminal IP address and leave the port at 1802. 

 

 
 
5. From the pull down menu, select "Tools/Select Debug levels". Set all levels to 9 

except Data stream and SNA. 
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6. With the RF terminal sitting at the "Press Any Key" prompt, select "Actions/Start 
Monitor". 
 

7. Press a key on the RF terminal to open a session, and you should see trace data in the 
RF Monitor window. When done, end the trace and the file will be named 
tnxxx.yyy.log (where xxx.yyy is the last 2 octets of the RF terminals IP address) in 
the directory in which RF Monitor was running. 
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Common Problems with RF Monitor 
 

• = The trace won’t start.  

RF Monitor uses UDP to send commands to the RF Device. On busy networks UDP 
packets are not always delivered. The terminal can miss the command to start the 
trace. Below are some things that can be useful: 
 
a. Ping the RF terminal from the same PC before starting RF Monitor (seems to 

"open" a path to the terminal). 

b. Start the monitor with the terminal at the "Press Any Key" prompt. (While the 
terminal is at this prompt, it's not doing much and has a better chance of hearing 
the start trace command.) 

 
• = I don't understand what this trace means. 

 
The trace that this tool collects is engineering level information. It allows an end user 
to collect information that can be analyzed by Connect engineering. 
 
It will generally be requested by Connect support to help diagnose a reported 
problem. 
 
To be able to read and understand these completely, you need to have an 
understanding of: 
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a. Emulation protocols (IBM 5250, IBM3270, DEC VT200, etc.) 
b. PowerNet Twin Client products 
c. RF Network concepts 
d. Wired network concepts 
e. Telnet sessions 
f.  TCP/IP  

 
They are text files that can be read with any editor or viewer and can be useful to end 
users and integrators even if they may not have all the requirements above. 

 
• = I have an intermittent problem and it could happen on any one of my 100 

terminals. RF Monitor only does one terminal at a time. What can I do? 
 
RF Monitor is not the right diagnostic tool for this type of problem. PowerNet 
products have another diagnostic tool that can be used called the "Diagnostic Server".  
 
This tool can be setup to run trace diagnostics on up to 300 terminals at the same 
time. This tool will be provided as needed for systems under PowerNet support 
agreement OR by T&M when they are not covered. 
 
It also includes the service of a PowerNet support engineer. 

 
Server Transfer is another feature. From the Tools menu, select Server Transfer. 

 
The FTP Settings screen appears. 

 
 
To send object editor and configuration files from Windows to your Linux box, enter 
your server address, and click on OK. 
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Serial Download of Configuration Files 
The automated configuration management provided by the Twin Client Manager 
eliminates the need for a serial download of the terminal configuration. However, this 
function can be accomplished manually by clicking on Send Configuration Files to 
Terminal. 

Note: This procedure assumes that the Twin Client had been installed. 

 

The following figure is displayed. 

 

The procedure for running the LD.BAT utility on the terminal is described in the 
following sub-sections. 

Warm Boot the Terminal 
On the portable terminal, reboot the terminal using the key sequence specific to the 
terminal model as shown in the following table. 
 

Warm Boot Sequences 

Terminal Model & Keypad Key Sequence 
960 5250, 45-Key 
TN3270 960/SL, 45-Key 

Press and release – key.  
Press and release Func. 
Press and release Enter.  
Press and release Func. 

PTC-960SL, 45-Key Press and release Ctrl.  
Press and release Alt.  
Press and release Func.  
Press and release Delete.  

V-Term, 54- Key 
(VT-100, VT-220, HP-700) 
 

Press and release Ctrl.  
Press and release Alt. 
Press and release Delete. 

TN3270 PTC-860IM 
TN5250 PTC-860IM 

Press and release Func.  
Press and release Pg up.  
Press and release Pg dn. 
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If a configuration has already been downloaded to the terminal, or this is not the first time 
the terminal has been rebooted, skip the next section and proceed to the section entitled 
Reloading the Configuration Files. 

First-time Download of Configuration Files 
Click OK on the PC to begin the download. After the download, warm boot the terminal, 
after which the following is displayed on the terminal. 
 
Twin Client 
© 1991-2004, Connect, Inc. 
 
Keypress to Continue  

The terminal is now ready to begin a Telnet session using the configuration files just 
downloaded. 

Reloading the Configuration Files 
Reloading the configuration files through the serial port requires that LD.BAT be executed 
manually, before the radio driver is installed. This is accomplished by interrupting the 
normal Twin Client startup process using the following technique: 

Press Shift + C on the terminal to Edit Function Menu. Scroll to the Exit using the  
Func + Down-Arrow, and press Enter. 

 
Edit Functions 
Edit IP 
Edit Host List 
Edit Radio 
Edit Authorization 
Switch Modes 
Run Emulation 
Exit  

Press the On/Off button on the terminal, shutting down the terminal. 
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Command Safe Boot 
The Command Safe Boot bypasses all configuration files and places the terminal in DOS 
Mode. On the portable terminal, boot the terminal using the key sequence specific to the 
terminal model as shown in the following table. 
 

Safe Boot Sequences 
Following Power OFF 

Terminal Model & Keypad Key Sequence 
960 5250, 45-Key 
TN3270 960/SL, 45-Key 

Press and hold the - and Tab keys, then 
press and release On/Off. 
Release - and Tab keys when cursor 
appears in the upper left corner of 
terminal screen. 
 

PTC-960SL, 45-Key Press and hold the Ctrl and Enter keys, 
then press and release On/Off. 
Release Ctrl and Enter keys when cursor 
appears in the upper left corner of 
terminal screen.  

V-Term, 54- Key 
(VT-100, VT-220, HP-700) 
 

Press and hold the V and Enter keys, 
Press and release On/Off. 
Release V and Enter keys when cursor 
appears in the upper left corner of 
terminal screen.  

TN3270 PTC-860IM 
TN5250 PTC-860IM 

Press and hold the Enter and Tab keys, 
Press and release On/Off. 
Release Enter and Tab keys when cursor 
appears in the upper left corner of 
terminal screen. 

Once the keys are released the terminal screen will scroll. The following should be 
displayed on the terminal screen. 
 

Current Date is: (Example Wed 08-08-00) 
Enter new date: (mm-dd-yy): _ 
Current time is: (Example12:53:03.86p) 
Enter new time: _ 

The terminal will display the current date and time. If the display is not accurate, enter 
manually. 

Press Enter for models (PTC-960SL), (VT-100, VT-220, HP-700) and/or Tab for 
(TN3270 PTC-860IM, TN5250 PTC-860IM) 

The terminal will scroll to a DOS prompt (C>), type ld and press Enter. 
 
Microsoft ® MS-DOS ® 
ROM Version 5.00 
© copyright Microsoft 
Corp  1981-1991, (3.0 
C> ld  
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Press OK on Twin Client Manager. 

 

The Terminal is downloading is setup files from the PC. When the download is 
completed the DOS prompt will appear on the terminal screen. 

Next, warm boot the terminal as explained previously. 

The next terminal screens appear as follows. 
 
Twin Client 
© 1991-2004, Connect, Inc. 
 
Keypress to Continue  

The terminal is now ready to begin a Telnet session with the new setup files. 

Creating Custom ARC Images 
A custom ARC file can be created for serial download to the terminal. The custom 
ARC file can be built with the currently opened Twin Client configuration information, 
and is useful if the automatic configuration management capabilities are not used. 

For instructions on creating the Arc file, see Creating Telxon Arc Files. 

Refer to Configuring the Terminal for Download for the detailed instructions to complete 
the download. 
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Chapter 9 • Character Sets 

ISO 8859-1 Character Set 
 

Description Char Dec Hex 

non-breaking space  160 A0 

inverted exclamation ¡ 161 A1 

cent sign ¢ 162 A2 

pound sterling £ 163 A3 

general currency sign ¤ 164 A4 

yen sign ¥ 165 A5 

broken vertical bar ¦ 166 A6 

section sign § 167 A7 

umlaut (dieresis) ¨ 168 A8 

copyright © 169 A9 

feminine ordinal ª 170 AA 

left angle quote, guillemot left « 171 AB 

not sign ¬ 172 AC 

soft hyphen - 173 AD 

registered trademark ® 174 AE 

macron accent ¯ 175 AF 

degree sign ° 176 B0 

plus or minus ± 177 B1 

superscript two ² 178 B2 

superscript three ³ 179 B3 

acute accent ´ 180 B4 

microsign µ 181 B5 
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Description Char Dec Hex 

paragraph sign ¶ 182 B6 

middle dot · 183 B7 

cedilla ¸ 184 B8 

superscript one ¹ 185 B9 

masculine ordinal º 186 BA 

right angle quote, guillemot right » 187 BB 

fraction one-fourth ¼ 188 BC 

fraction one-half ½ 189 BD 

fraction three-fourths ¾ 190 BE 

inverted question mark ¿ 191 BF 

capital A, grave accent À 192 C0 

capital A, acute accent Á 193 C1 

capital A, circumflex accent Â 194 C2 

capital A, tilde Ã 195 C3 

capital A, dieresis or umlaut mark Ä 196 C4  

capital A, ring Å 197 C5 

capital AE diphthong (ligature) Æ 198 C6 

capital C, cedilla Ç 199 C7 

capital E, grave accent È 200 C8 

capital E, acute accent É 201 C9 

capital E, circumflex accent Ê 202 CA 

capital E, dieresis or umlaut mark Ë 203 CB 

capital I, grave accent Ì 204 CC 

capital I, acute accent Í 205 CD 

capital I, circumflex accent Î 206 CE 

capital I, dieresis or umlaut mark Ï 207 CF 

capital Eth, Icelandic Ð 208 D0 

capital N, tilde Ñ 209 D1 

capital O, grave accent Ò 210 D2 



  ISO 8859-1 Character Set 

Twin Client Reference   •    June, 2004    9-3

Description Char Dec Hex 

capital O, acute accent Ó 211 D3 

capital O, circumflex accent Ô 212 D4 

capital O, tilde Õ 213 D5 

capital O, dieresis or umlaut mark Ö 214 D6 

multiply sign × 215 D7 

capital O, slash Ø 216 D8 

capital U, grave accent Ù 217 D9 

capital U, acute accent Ú 218 DA 

capital U, circumflex accent Û 219 DB 

capital U, dieresis or umlaut mark Ü 220 DC 

capital Y, acute accent Ý 221 DD 

capital THORN, Icelandic Þ 222 DE 

small sharp s, German (sz ligature) ß 223 DF 

small A, grave accent à 224 E0 

small A, acute accent á 225 E1 

small A, circumflex accent â 226 E2 

small A, tilde ã 227 E3 

small A, dieresis or umlaut mark ä 228 E4 

small A, ring å 229 E5 

small AE diphthong (ligature) æ 230 E6 

small C, cedilla ç 231 E7 

small E, grave accent è 232 E8 

small E, acute accent é 233 E9 

small E, circumflex accent ê 234 EA 

small E, dieresis or umlaut mark ë 235 EB 

small I, grave accent ì 236 EC 

small I, acute accent í 237 ED 

small I, circumflex accent î 238 EE 

small I, dieresis or umlaut mark ï 239 EF 
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Description Char Dec Hex 

small Eth, Icelandic ð 240 F0 

small N, tilde ñ 241 F1 

small O, grave accent ò 242 F2 

small O, acute accent ó 243 F3 

small O, circumflex accent ô 244 F4 

small O, tilde õ 245 F5 

small O, dieresis or umlaut mark ö 246 F6 

division sign ÷ 247 F7 

small O, slash ø 248 F8 

small U, grave accent ù 249 F9 

small U, acute accent ú 250 FA 

small U, circumflex accent û 251 FB 

small U, dieresis or umlaut mark ü 252 FC 

small Y, acute accent ý 253 FD 

small THORN, Icelandic þ 254 FE 

small Y, dieresis or umlaut mark ÿ 255 FF 
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ASCII Character Set 
Decimal and Hexadecimal Values 
 

 Dec Hex  Dec Hex  Dec Hex  Dec Hex 
NUL 0 00 SP 32 20 @ 64 40 ` 96 60 
SOH 1 01 ! 33 21 A 65 41 a 97 61 
STX 2 02 " 34 22 B 66 42 b 98 62 
ETX 3 03 # 35 23 C 67 43 c 99 63 
EOT 4 04 $ 36 24 D 68 44 d 100 64 
ENQ 5 05 % 37 25 E 69 45 e 101 65 
ACK 6 06 & 38 26 F 70 46 f 102 66 
BEL 7 07 ´ 39 27 G 71 47 g 103 67 

BS 8 08 ( 40 28 H 72 48 h 104 68 
HT 9 09 ) 41 29 I 73 49 i 105 69 
NL 10 0A * 42 2A J 74 4A j 106 6A
VT 11 0B + 43 2B K 75 4B k 107 6B 
NP 12 0C , 44 2C L 76 4C l 108 6C 
CR 13 0D - 45 2D M 77 4D m 109 6D 
SO 14 0E . 46 2E N 78 4E n 110 6E 
SI 15 0F / 47 2F O 79 4F o 111 6F 

DLE 16 10 0 48 30 P 80 50 p 112 70 
DC1 17 11 1 49 31 Q 81 51 q 113 71 
DC2 18 12 2 50 32 R 82 52 r 114 72 
DC3 19 13 3 51 33 S 83 53 s 115 73 
DC4 20 14 4 52 34 T 84 54 t 116 74 

NAK 21 15 5 54 35 U 85 55 u 117 75 
SYN 22 16 6 54 36 V 86 56 v 118 76 
ETB 23 17 7 55 37 W 87 57 w 119 77 
CAN 24 18 8 56 38 X 88 58 x 120 78 

EM 25 19 9 57 39 Y 89 59 y 121 79 
SUB 26 1A : 58 3A Z 90 5A z 122 7A
ESC 27 1B ; 59 3B [ 91 5B { 123 7B 

FS 28 1C < 60 3C \ 92 5C | 124 7C 
GS 29 1D = 61 3D ] 93 5D } 125 7D 
RS 30 1E > 62 3E ^ 94 5E ~ 126 7E 
US 31 1F ? 63 3F _ 95 5F DEL 127 7F 
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ASCII Character Set 
Octal Values 
 

 Oct  Oct  Oct Oct 
NUL 000 SP 040 @ 100 ` 140 
SOH 001 ! 041 A 101 a 141 
STX 002 " 042 B 102 b 142 
ETX 003 # 043 C 103 c 143 
EOT 004 $ 044 D 104 d 144 
ENQ 005 % 045 E 105 e 145 
ACK 006 & 046 F 106 f 146 
BEL 007 ´ 047 G 107 g 147 

BS 010 ( 050 H 110 h 150 
HT 011 ) 051 I 111 i 151 
NL 012 * 052 J 112 j 152 
VT 013 + 053 K 113 k 153 
NP 014 , 054 L 114 l 154 
CR 015 - 055 M 115 m 155 
SO 016 . 056 N 116 n 156 
SI 017 / 057 O 117 o 157 

DLE 020 0 060 P 120 p 160 
DC1 021 1 061 Q 121 q 161 
DC2 022 2 062 R 122 r 162 
DC3 023 3 063 S 123 s 163 
DC4 024 4 064 T 124 t 164 

NAK 025 5 065 U 125 u 165 
SYN 026 6 066 V 126 v 166 
ETB 027 7 067 W 127 w 167 
CAN 030 8 070 X 130 x 170 

EM 031 9 071 Y 131 y 171 
SUB 032 : 072 Z 132 z 172 
ESC 033 ; 073 [ 133 { 173 

FS 034 < 074 \ 134 | 174 
GS 035 = 075 ] 135 } 175 
RS 036 > 076 ^ 136 ~ 176 
US 037 ? 077 _ 137 DEL 177 
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Chapter 10 • Keypad Configuration 
This chapter describes the default Twin Client key assignments applied to Telxon 
terminals used in Twin Client advanced mode. The figures and tables identify the key 
assignments by terminal model and emulation. 

Adhesive decals that reflect the configurations described in this chapter are available for 
Telxon terminals in each of the emulations (3270, 5250, and VT/HP). 

Keypad Figures 
The keypad figures in this section are designed to be of use without color. The 
convention for describing the effect of modifier keys is as follows: 
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PTC-960SL 5250 Keyboard 
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PTC-860IM VT/HP Keyboard 
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PTC-860IM 3270 Keyboard 
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PTC-860IM 5250 Keyboard 
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Telxon Terminal Keypad Tables 
The keypad tables in this section are organized by terminal model, keypad configuration, 
and emulation. The key values represent the default Twin Client keypad assignments 
applied to the terminal in Twin Client advanced mode. Table entries that are blank 
indicate the key is not assigned, or not relevant to the emulation. 

PTC-960, 45-key 
 

KEY 5250 3270 VT/HP 
a <a> <a> <a> 
b <b> <b> <b> 
c <c> <c> <c> 
d <d> <d> <d> 
e <e> <e> <e> 
f <f> <f> <f> 
g <g> <g> <g> 
h <h> <h> <h> 
i <i> <i> <i> 
j <j> <j> <j> 
k <k> <k> <k> 
l <l> <l> <l> 
m <m> <m> <m> 
n <n> <n> <n> 
o <o> <o> <o> 
p <p> <p> <p> 
q <q> <q> <q> 
r <r> <r> <r> 
s <s> <s> <s> 
t <t> <t> <t> 
u <u> <u> <u> 
v <v> <v> <v> 
w <w> <w> <w> 
x <x> <x> <x> 
y <y> <y> <y> 
z <z> <z> <z> 
A <SHF><a> <SHF><a> <SHF><a> 
B <SHF><b> <SHF><b> <SHF><b> 
C <SHF><c> <SHF><c> <SHF><c> 
D <SHF><d> <SHF><d> <SHF><d> 
E <SHF><e> <SHF><e> <SHF><e> 
F <SHF><f> <SHF><f> <SHF><f> 
G <SHF><g> <SHF><g> <SHF><g> 
H <SHF><h> <SHF><h> <SHF><h> 
 I <SHF><I> <SHF><I> <SHF><i> 
J <SHF><j> <SHF><j> <SHF><j> 
K <SHF><k> <SHF><k> <SHF><k> 
L <SHF><l> <SHF><l> <SHF><l> 
M <SHF><m> <SHF><m> <SHF><m> 
N <SHF><n> <SHF><n> <SHF><n> 
O <SHF><o> <SHF><o> <SHF><o> 
P <SHF><p> <SHF><p> <SHF><p> 
Q <SHF><q> <SHF><q> <SHF><q> 
R <SHF><r> <SHF><r> <SHF><r> 
S <SHF><s> <SHF><s> <SHF><s> 
T <SHF><t> <SHF><t> <SHF><t> 
U <SHF><u> <SHF><u> <SHF><u> 
V <SHF><v> <SHF><v> <SHF><v> 
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KEY 5250 3270 VT/HP 
W <SHF><w> <SHF><w> <SHF><w> 
X <SHF><x> <SHF><x> <SHF><x> 
Y <SHF><y> <SHF><y> <SHF><y> 
Z <SHF><z> <SHF><z> <SHF><z> 
Altcr <RFNC><K> <RFNC><K>  
Attention <RFNC><A> <RFNC><A>  
Backlight   <BACKLIGHT> 
Back Tab <SHF><TAB>> <SHF><TAB>>  
Back Tab <RFNC><Y>   
Backspace <BKSP> <BKSP> <BKSP> 
Break   <FUNC><ESC> 
Caps Lock <RFNC><G> <RFNC><G> <FUNC><SHF> 
Contrast -   <CONTRAST UP> 
Contrast +   <CONTRAST DN> 
Cursor Down (DAR) <LFNC><V> <LFNC><V> <FUNC><B> 
Cursor Left (FAR) <LFNC><U> <LFNC><U> <FUNC><E> 
Cursor Right (BAR) <LFNC><W> <LFNC><W> <FUNC><F> 
Cursor Up (UAR) <LFNC><Q> <LFNC><Q> <FUNC><A> 
Clear <RFNC><C> <RFNC><C>  
Delete <RFNC><D> <RFNC><D> <FUNC><ALT> 
Dup <RFNC><N>   
EINFL <RFNC><E> <RFNC><E>  
Enter <TAB> <TAB> <ENTER> 
Erase Field    
Erase EOF <RFNC><O> <RFNC><O>  
Escape   <ESC> 
Exit <RFNC><M> <RFNC><M>  
Field Advance <RFNC><TAB>   
Field Exit <LFNC><ENTER>   
Field Minus <LFNC><TAB>   
Help <RFNC><BKSP> <RFNC><BKSP>  
Home <RFNC><H> <RFNC><H>  
Insert <RFNC><I> <RFNC><I>  
LCD <RFNC><J> <RFNC><J>  
Light <RFNC><L> <RFNC><L>  
Print  <RFNC><P> <RFNC><P> <FUNC><P> 
Reset <RFNC><R> <RFNC><R>  
Return <ENTER> <ENTER> <ENTER> 
Roll Down <RFNC><F>   
Scroll Lock   <FUNC><S> 
Roll Up <RFNC><B>   
Space <SPACE> <SPACE> <SPACE> 
Stat <RFNC><T> <RFNC><T>  
Sys Request <RFNC><S> <RFNC><S>  
Tab <TAB> <TAB>  
View Down <RFNC><V> <RFNC><V>  
View Left <RFNC><U> <RFNC><U>  
View Right <RFNC><W> <RFNC><W>  
View Up <RFNC><Q> <RFNC><Q>  
PA1  <RFNC><X>  
PA2  <RFNC><Y>  
PA3   <RFNC><Z>  
F1 <LFNC><1> <LFNC><1> <FUNC><1> 
F2 <LFNC><2> <LFNC><2> <FUNC><2> 
F3 <LFNC><3> <LFNC><3> <FUNC><3> 
F4 <LFNC><4> <LFNC><4> <FUNC><4> 
F5 <LFNC><5> <LFNC><5> <FUNC><5> 
F6 <LFNC><6> <LFNC><6> <FUNC><6> 
F7 <LFNC><7> <LFNC><7> <FUNC><7> 
F8 <LFNC><8> <LFNC><8> <FUNC><8> 
F9 <LFNC><9> <LFNC><9> <FUNC><9> 
F10 <LFNC><0> <LFNC><0> <FUNC><0> 
F11 <RFNC><1> <RFNC><1>  
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KEY 5250 3270 VT/HP 
F12 <RFNC><2> <RFNC><2>  
F13 <RFNC><3> <RFNC><3>  
F14 <RFNC><4> <RFNC><4>  
F15 <RFNC><5> <RFNC><5>  
F16 <RFNC><6> <RFNC><6>  
F17 <RFNC><7> <RFNC><7>  
F18 <RFNC><8> <RFNC><8>  
F19 <RFNC><9> <RFNC><9>  
F20 <RFNC><0> <RFNC><0>  
F21 <LFNC>< DASH> <LFNC>< DASH>  
F22 <RFNC><DASH> <RFNC><DASH>  
F23 <LFNC><SPACE> <LFNC><SPACE>  
F24 <RFNC><SPACE> <RFNC><SPACE>  
1 <1> <1> <1> 
2 <2> <2> <2> 
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
!                 exclamation  <SHF><1> <SHF><1> <SHF><1> 
@                        at sign <SHF><2> <SHF><2> <SHF><2> 
#                          pound <SHF><3> <SHF><3> <SHF><3> 
$                           dollar <SHF><4> <SHF><4> <SHF><4> 
%                      percent <SHF><5> <SHF><5> <SHF><5> 
^                            carat <SHF><6> <SHF><6> <SHF><6> 
&                ampersand <SHF><7> <SHF><7> <SHF><7> 
(           left parenthesis <SHF><9> <SHF><9> <SHF><9> 
)        right parenthesis <SHF><0> <SHF><0> <SHF><0> 
-                             dash <DASH> <DASH> <FUNC><K> 
+                             plus <LFNC><P> <LFNC><P> <FUNC><H> 
'                  apostrophe <LFNC><G> <LFNC><G> <FUNC><M> 
“                           quote <LFNC><C> <LFNC><C> <FUNC><R> 
*                        asterisk <SHF><8> <SHF><8> <SHF><8> 
,                         comma <LFNC><O> <LFNC><O> <FUNC><U> 
.                          period <SHF><SPACE> <SHF><SPACE> <FUNC><W> 
/              forward slash <LFNC><Y> <LFNC><Y> <FUNC><Y> 
[                  left bracket <LFNC><M> <LFNC><M> <FUNC><I> 
\                   back slash <LFNC><H> <LFNC><H> <FUNC><C> 
]               right bracket <LFNC><R> <LFNC><R> <FUNC><J> 
_                    underline <SHF><DASH> <SHF><DASH> <FUNC><L> 
`               grave accent      <FUNC><Q> 
:                           colon <LFNC><I> <LFNC><I> <FUNC><N> 
;                  semi-colon <LFNC><J> <LFNC><J> <FUNC><O> 
<                    less than <LFNC><T> <LFNC><T> <FUNC><T> 
=                          equal <LFNC><Z> <LFNC><Z> <FUNC><G> 
>               greater than <LFNC><X> <LFNC><X> <FUNC><V> 
?                    question <LFNC><K> <LFNC><K> <FUNC><X> 
{                    left brace <LFNC><N> <LFNC><N>  
|                  vertical bar <LFNC><D> <LFNC><D> <FUNC><D> 
}                  right brace <LFNC><S> <LFNC><S>  
~                            tilde <LFNC><E> <LFNC><E> <FUNC><Z> 

Note: Full 8859 character set not supported. 



Keypad Configuration 

  Twin Client Reference    •    June, 2004 10-12

PTC-960, 45-key (ANSI) 
 

KEY 5250 3270 
a <a> <a> 
b <b> <b> 
c <c> <c> 
d <d> <d> 
e <e> <e> 
f <f> <f> 
g <g> <g> 
h <h> <h> 
i <i> <i> 
j <j> <j> 
k <k> <k> 
l <l> <l> 
m <m> <m> 
n <n> <n> 
o <o> <o> 
p <p> <p> 
q <q> <q> 
r <r> <r> 
s <s> <s> 
t <t> <t> 
u <u> <u> 
v <v> <v> 
w <w> <w> 
x <x> <x> 
y <y> <y> 
z <z> <z> 
A <SHF><a> <SHF><a> 
B <SHF><b> <SHF><b> 
C <SHF><c> <SHF><c> 
D <SHF><d> <SHF><d> 
E <SHF><e> <SHF><e> 
F <SHF><f> <SHF><f> 
G <SHF><g> <SHF><g> 
H <SHF><h> <SHF><h> 
 I <SHF><i> <SHF><i> 
J <SHF><j> <SHF><j> 
K <SHF><k> <SHF><k> 
L <SHF><l> <SHF><l> 
M <SHF><m> <SHF><m> 
N <SHF><n> <SHF><n> 
O <SHF><o> <SHF><o> 
P <SHF><p> <SHF><p> 
Q <SHF><q> <SHF><q> 
R <SHF><r> <SHF><r> 
S <SHF><s> <SHF><s> 
T <SHF><t> <SHF><t> 
U <SHF><u> <SHF><u> 
V <SHF><v> <SHF><v> 
W <SHF><w> <SHF><w> 
X <SHF><x> <SHF><x> 
Y <SHF><y> <SHF><y> 
Z <SHF><z> <SHF><z> 
Attention <ALT><A> <ALT><A> 
Backlight <BACKLIGHT> <BACKLIGHT> 
Back Tab <SHF><ESC> <SHF><ESC> 
Backspace <BKSP> <BKSP> 
Caps Lock <FUNC><SHF> <FUNC><SHF> 
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KEY 5250 3270 
Contrast - <CONTRAST DOWN> <CONTRAST DOWN > 
Contrast + <CONTRAST UP> <CONTRAST UP> 
Cursor Down (DAR) <FUNC><B> <FUNC><B> 
Cursor Left (FAR) <FUNC><E> <FUNC><E> 
Cursor Right (BAR) <FUNC><F> <FUNC><F> 
Cursor Up (UAR) <FUNC><A> <FUNC><A> 
Clear <ALT><C> <ALT><C> 
Delete <ALT><D> <ALT><D> 
Enter <ENTER> <ENTER> 
Erase EOF <ALT><O> <ALT><O> 
Field Exit <FUNC><ENTER> <FUNC><ENTER> 
Help <CTRL><H> <CTRL><H> 
Home <ALT><H> <ALT><H> 
Insert <ALT><I> <ALT><I> 
Print <ALT><P> <ALT><P> 
Reset <ALT><R> <ALT><R> 
Return <ENTER> <ENTER> 
Roll Down <ALT><F>  
Roll Up <ALT><B>  
Space <SPACE> <SPACE> 
Sys Request <ALT><S> <ALT><S> 
Tab <ESC> <ESC> 
View Down <ALT><V> <ALT><V> 
View Left <ALT><U> <ALT><U> 
View Right <ALT><W> <ALT><W> 
View Up <ALT><Q> <ALT><Q> 
PA1  <ALT><X> 
PA2  <ALT><Y> 
PA3   <ALT><Z> 
F1 <FUNC><1> <FUNC><1> 
F2 <FUNC><2> <FUNC><2> 
F3 <FUNC><3> <FUNC><3> 
F4 <FUNC><4> <FUNC><4> 
F5 <FUNC><5> <FUNC><5> 
F6 <FUNC><6> <FUNC><6> 
F7 <FUNC><7> <FUNC><7> 
F8 <FUNC><8> <FUNC><8> 
F9 <FUNC><9> <FUNC><9> 
F10 <FUNC><0> <FUNC><0> 
F11 <ALT><1> <ALT><1> 
F12 <ALT><2> <ALT><2> 
F13 <ALT><3> <ALT><3> 
F14 <ALT><4> <ALT><4> 
F15 <ALT><5> <ALT><5> 
F16 <ALT><6> <ALT><6> 
F17 <ALT><7> <ALT><7> 
F18 <ALT><8> <ALT><8> 
F19 <ALT><9> <ALT><9> 
F20 <ALT><0> <ALT><0> 
F21 <SHF><FUNC>< 1> <SHF><FUNC>< 1> 
F22 <SHF><FUNC>< 2> <SHF><FUNC>< 2> 
F23 <SHF><FUNC>< 3> <SHF><FUNC>< 3> 
F24 <SHF><FUNC>< 4> <SHF><FUNC>< 4> 
1 <1> <1> 
2 <2> <2> 
3 <3> <3> 
4 <4> <4> 
5 <5> <5> 
6 <6> <6> 
7 <7> <7> 
8 <8> <8> 
9 <9> <9> 
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KEY 5250 3270 
0 <0> <0> 
!                exclamation  <SHF><1> <SHF><1> 
@                       at sign <SHF><2> <SHF><2> 
#                         pound <SHF><3> <SHF><3> 
$                          dollar <SHF><4> <SHF><4> 
%                      percent <SHF><5> <SHF><5> 
^                           carat <SHF><6> <SHF><6> 
&                ampersand <SHF><7> <SHF><7> 
(          left parenthesis <SHF><9> <SHF><9> 
)       right parenthesis <SHF><0> <SHF><0> 
-                            dash <FUNC><K> <FUNC><K> 
+                            plus <FUNC><H> <FUNC><H> 
'                 apostrophe <FUNC><M> <FUNC><M> 
*                      asterisk <SHF><8> <SHF><8> 
,                       comma <FUNC><U> <FUNC><U> 
.                         period <FUNC><W> <FUNC><W> 
/             forward slash <FUNC><Y> <FUNC><Y> 
[                 left bracket <FUNC><I> <FUNC><I> 
\                  back slash <FUNC><C> <FUNC><C> 
]              right bracket <FUNC><J> <FUNC><J> 
_                   underline <FUNC><L> <FUNC><L> 
`              grave accent     <FUNC><Q> <FUNC><Q> 
:                          colon <FUNC><N> <FUNC><N> 
;                 semi-colon <FUNC><O> <FUNC><O> 
{                   left brace <FUNC><R> <FUNC><R> 
}                 right brace <FUNC><S> <FUNC><S> 
<                   less than <FUNC><T> <FUNC><T> 
=                         equal <FUNC><G> <FUNC><G> 
>              greater than <FUNC><V> <FUNC><V> 
?                   question <FUNC><X> <FUNC><X> 
|                vertical bar <FUNC><D> <FUNC><D> 
~                           tilde <FUNC><Z> <FUNC><Z> 

Note: Full 8859 character set not supported. 
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PTC-860, 54-key 
 
KEY 5250 3270 VT/HP 

a <a> <a> <a> 
b <b> <b> <b> 
c <c> <c> <c> 
d <d> <d> <d> 
e <e> <e> <e> 
f <f> <f> <f> 
g <g> <g> <g> 
h <h> <h> <h> 
i <i> <i> <i> 
j <j> <j> <j> 
k <k> <k> <k> 
l <l> <l> <l> 
m <m> <m> <m> 
n <n> <n> <n> 
o <o> <o> <o> 
p <p> <p> <p> 
q <q> <q> <q> 
r <r> <r> <r> 
s <s> <s> <s> 
t <t> <t> <t> 
u <u> <u> <u> 
v <v> <v> <v> 
w <w> <w> <w> 
x <x> <x> <x> 
y <y> <y> <y> 
z <z> <z> <z> 
A <SHF><a> <SHF><a> <SHF><a> 
B <SHF><b> <SHF><b> <SHF><b> 
C <SHF><c> <SHF><c> <SHF><c> 
D <SHF><d> <SHF><d> <SHF><d> 
E <SHF><e> <SHF><e> <SHF><e> 
F <SHF><f> <SHF><f> <SHF><f> 
G <SHF><g> <SHF><g> <SHF><g> 
H <SHF><h> <SHF><h> <SHF><h> 
I <SHF><i> <SHF><i> <SHF><i> 
J <SHF><j> <SHF><j> <SHF><j> 
K <SHF><k> <SHF><k> <SHF><k> 
L <SHF><l> <SHF><l> <SHF><l> 
M <SHF><m> <SHF><m> <SHF><m> 
N <SHF><n> <SHF><n> <SHF><n> 
O <SHF><o> <SHF><o> <SHF><o> 
P <SHF><p> <SHF><p> <SHF><p> 
Q <SHF><q> <SHF><q> <SHF><q> 
R <SHF><r> <SHF><r> <SHF><r> 
S <SHF><s> <SHF><s> <SHF><s> 
T <SHF><t> <SHF><t> <SHF><t> 
U <SHF><u> <SHF><u> <SHF><u> 
V <SHF><v> <SHF><v> <SHF><v> 
W <SHF><w> <SHF><w> <SHF><w> 
X <SHF><x> <SHF><x> <SHF><x> 
Y <SHF><y> <SHF><y> <SHF><y> 
Z <SHF><z> <SHF><z> <SHF><z> 
ALT --- <ALT>  <ALT> 
Altcr <Right Func><k> --- --- 
Attention <Right Func><a>> <ALT><A>  
Back Tab <Shift><Tab>  <FUNC><A> 
Backspace <BKSP> <BKSP> <BKSP> 
Break --- <FUNC><ESC> <FUNC><ESC> 
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Caps <Right Func><g> <FUNC><SHF> <FUNC><SHF> 
Clear <Right Func><c> <ALT><C>  
CTRL --- <CTRL> <CTRL> 
Cursor Down <▼> <▼> <▼> 
Cursor Left <◄> <◄> <◄> 
Cursor Right <►> <►> <►> 
Cursor Up <▲> <▲> <▲> 
Delete <DEL> <DEL> <DEL> 
Dup <Right Func><d> <ALT><D>  
End --- <FUNC><►> <FUNC><►> 
Enter <ENTER> <ENTER> <ENTER> 
Erinp <Right Func><e> <ALT><E>  
Escape --- <ESC> <ESC> 
Exit <Right Func><m> --- --- 
Field Exit <Right Func><x>   
Func --- <FUNC> <FUNC> 
Left Func <Left Func> --- --- 
Right Func <Right Func> --- --- 
LCD <Right Func><j> --- --- 
Light <Right Func><l> --- --- 
Help <Shift><Bksp> --- --- 
Home <Right Func><h> <ALT><H>  
Info --- <ALT><I>  
Insert <Left Func><DEL> <FUNC><DEL>  
Page Down  <Right Func><▼> <FUNC><▼> <FUNC><▼> 
Page Up  <Right Func><▲> <FUNC><▲> <FUNC><▲> 
Page Left <Right Func><◄> --- --- 
Page Right <Right Func><►> --- --- 
Print <Right Func><p> <ALT><P>  
Reset <Right Func><r> <ALT><R>  
Roll Up <Shift><▲>   
Roll Down <Shift><▼>   
Scroll Lock --- <FUNC><S> <FUNC><S> 
Scroll Down <Left Func><▼> --- --- 
Scroll Left <Left Func><◄> --- --- 
Scroll Right <Left Func><►> --- --- 
Scroll Up <Left Func><▲> --- --- 
Shift <SHIFT> <SHIFT> <SHIFT> 
Space <SPACE> <SPACE> <SPACE> 
Stat <Right Func><u> --- --- 
Sys Req <Right Func><s> <ALT><S>  
Tab <TAB>  <FUNC><B> 
View Down --- <CTRL><▼>  
View Left --- <CTRL><◄>  
View Right --- <CTRL><►>  
View Up --- <CTRL><▲>  
F1 <Left Func><1> <FUNC><1> <FUNC><1> 
F2 <Left Func><2> <FUNC><2> <FUNC><2> 
F3 <Left Func><3> <FUNC><3> <FUNC><3> 
F4 <Left Func><4> <FUNC><4> <FUNC><4> 
F5 <Left Func><5> <FUNC><5> <FUNC><5> 
F6 <Left Func><6> <FUNC><6> <FUNC><6> 
F7 <Left Func><7> <FUNC><7> <FUNC><7> 
F8 <Left Func><8> <FUNC><8> <FUNC><8> 
F9 <Left Func><9> <FUNC><9> <FUNC><9> 
F10 <Left Func><0> <FUNC><0> <FUNC><0> 
F11 <Right Func><1> <ALT><1> <SHF><FUNC><1> 
F12 <Right Func><2> <ALT><2> <SHF><FUNC><2> 
F13 <Right Func><3> <ALT><3> <SHF><FUNC><3> 
F14 <Right Func><4> <ALT><4> <SHF><FUNC><4> 
F15 <Right Func><5> <ALT><5> <SHF><FUNC><5> 
F16 <Right Func><6> <alt><6> <shf><func><6> 
F17 <Right Func><7> <alt><7> <shf><func><7> 
F18 <Right Func><8> <ALT><8> <SHF><FUNC><8> 
F19 <Right Func><9> <ALT><9> <SHF><FUNC><9> 
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F20 <Right Func><0> <ALT><0> <SHF><FUNC><0> 
F21 <Left Func><-> <SHF><FUNC><1>  
F22 <Right Func><-> <SHF><FUNC><2>  
F23 <Left Func><Space> <SHF><FUNC><3>  
F24 <Right Func><Space> <SHF><FUNC><4>  
1 <1> <1> <1> 
2 <2> <2> <2> 
3 <3> <3> <3> 
4 <4> <4> <4> 
5 <5> <5> <5> 
6 <6> <6> <6> 
7 <7> <7> <7> 
8 <8> <8> <8> 
9 <9> <9> <9> 
0 <0> <0> <0> 
!            exclamation  <SHF><1> <SHF><1> <SHF><1> 
@                   at sign <SHF><2> <SHF><2> <SHF><2> 
#                     pound <SHF><3> <SHF><3> <SHF><3> 
$                       dollar <SHF><4> <SHF><4> <SHF><4> 
%                  percent <SHF><5> <SHF><5> <SHF><5> 
^                        carat <SHF><6> <SHF><6> <SHF><6> 
&             ampersand <SHF><7> <SHF><7> <SHF><7> 
(       left parenthesis <SHF><9> <SHF><9> <SHF><9> 
)    right parenthesis <SHF><0> <SHF><0> <SHF><0> 
-                         dash <-> <FUNC><E> <FUNC><E> 
+                         plus <Left Func><p> <FUNC><H> <FUNC><H> 
'              apostrophe <Left Func><g> <FUNC><Q> <FUNC><Q> 
“                       quote --- <FUNC><R> <FUNC><R> 
*                   asterisk <SHF><8> <SHF><8> <SHF><8> 
,                    comma <Left Func><o> <FUNC><U> <FUNC><U> 
.                      period <Shift><Space> <FUNC><W> <FUNC><W> 
/          forward slash <Left Func><x> <FUNC><Y> <FUNC><Y> 
[              left bracket <Left Func><q> <FUNC><I> <FUNC><I> 
\               back slash <Left Func><h> <FUNC><C> <FUNC><C> 
]           right bracket <Left Func><r> <FUNC><K> <FUNC><K> 
_                underline <Shift><-> <FUNC><F> <FUNC><F> 
`           grave accent   <Left Func><f> <FUNC><M> <FUNC><M> 
:                       colon <Left Func><i> <FUNC><N> <FUNC><N> 
;              semi-colon <Left Func><j> <FUNC><O> <FUNC><O> 
<                 less than <Left Func><t> <FUNC><T> <FUNC><T> 
=                       equal <Left Func><v> <FUNC><G> <FUNC><G> 
>            greater than <Left Func><u> <FUNC><V> <FUNC><V> 
?                 question <Left Func><k> <FUNC><X> <FUNC><X> 
{                 left brace <Left Func><n> <FUNC><J> <FUNC><J> 
|              vertical bar <Left Func><d> <FUNC><D> <FUNC><D> 
}              right brace <Left Func><s> <FUNC><L> <FUNC><L> 
~                        tilde <Left Func><e> <FUNC><Z> <FUNC><Z> 

 
Note: Full 8859 character set not supported. 
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Telxon Terminal Control Sequences 
Command Mode Safe Boot 

 
Safe Boot Sequences 

Following Power OFF 
Terminal Model & Keypad Key Sequence 

960 5250, 45-Key 
TN3270 960/SL, 45-Key 

Press and hold the – and Tab keys, 
then press and release On/Off. 
Release – and Tab keys when cursor 
appears in the upper left corner of 
terminal screen. 
 

PTC-960SL, 45-Key Press and hold the Ctrl and Enter 
keys, then press and release On/Off. 
Release Ctrl and Enter keys when 
cursor appears in the upper left corner 
of terminal screen. 

V-Term, 54- Key 
(VT-100, VT-220, HP-700) 
 

Press and hold the V and Enter keys, 
Press and release On/Off. 
Release V and Enter keys when cursor 
appears in the upper left corner of 
terminal screen. 

TN3270 PTC-860IM 
TN5250 PTC-860IM 

Press and hold the Enter and Tab 
keys, Press and release On/Off. 
Release Enter and Tab keys when 
cursor appears in the upper left corner 
of terminal screen. 
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Warm Boot  
 

Warm Boot Sequences 

Terminal Model & Keypad Key Sequence 

960 5250, 45-Key 
TN3270 960/SL, 45-Key 

Press and release – key. 
Press and release Func. 
Press and release Enter. 
Press and release Func. 

PTC-960SL, 45-Key Press and release Ctrl. 
Press and release Alt. 
Press and release Func. 
Press and release Delete. 

V-Term, 54- Key 
(VT-100, VT-220, HP-700) 
 

Press and release Ctrl.  
Press and release Alt. 
Press and release Delete. 

TN3270 PTC-860IM 
TN5250 PTC-860IM 

Press and release Func. 
Press and release Pg Up. 
Press and release Pg Dn. 

 



Keypad Configuration 

  Twin Client Reference    •    June, 2004 10-20

This page is intentionally blank.



 

Twin Client Reference    •    June, 2004  11-1

Chapter 11 • Error Message Resolution Guide 
Twin Client Error Message Resolution Guide 

 
Message Reason Solution Reference Tech Note 

ENTRY TOO LONG; Trying to key beyond the field size. Ensure that you are entering input into the 
correct field. 

--- 

ALPHABETIC ONLY; Trying to key a character that is not 
alphabetic. 

Ensure that you are entering input into the 
correct field. 

--- 

MINUS NOT VALID; Trying to key a Minus sign. Ensure that you are entering input into the 
correct field. 

--- 

DECIMAL NOT VALID; Trying to key a Decimal (period). Ensure that you are entering input into the 
correct field. 

--- 

ALPHANUMERIC ONLY; Trying to key characters other than 
Alphabetic and numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

NUMERIC ONLY; Trying to key characters other than 
numeric. 

Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

INVALID KEY; The key pressed is not valid. Ensure that you are entering input into the 
correct field. 

--- 
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Message Reason Solution Reference Tech Note 
    

MUST CLEAR FIELD; Trying to enter data in a field that 
must be cleared first. 

Ensure that you are entering input into the 
correct field. 

--- 

SCAN NOT ALLOWED; Trying to scan into a key only field. Ensure that you are entering input into the 
correct field. 

--- 

KEY NOT ALLOWED; Trying to key into a scan only field. Ensure that you are entering input into the 
correct field. 

--- 

ENTRY TOO SHORT; Trying to exit the field before it is 
filled. 

Ensure that you are entering input into the 
correct field. 

--- 

RECOVERABLE ERROR; Encountered an error from which 
you can continue. 

Verify your configuration settings for the 
hardware being used, usually a printer and 
cable issue. 

--- 

UNRECOVERABLE ERROR; Encountered an error from which 
you can NOT continue. 

Verify your Network settings are correct and 
you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

FUNCTION: \n\nFILE: \nLINE: \nCODE; Encountered an error from which 
you can NOT continue. 

Notify Connect over the WEB incident 
reporting system. 

--- 

Press any key\nFor More Details...; Press Enter for more information. Advisory message. --- 

Press any key; Press a key to continue. Advisory message. --- 

Connection ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Connect. Verify your Network settings are correct and 
you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Message Reason Solution Reference Tech Note 
    

Disconnect ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Disconnect. Verify your Network settings are correct and 
you are in the correct mode using the 
correct Port. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Send ERROR.\nREBOOT MOBILE 
UNIT; 

Could not Send. Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Receive ERROR.\nREBOOT 
MOBILE UNIT; 

Could not Receive. Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Check ERROR.\nREBOOT 
MOBILE UNIT; 

Could not run the RF Survey. Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

RF Timeout ERROR.\nREBOOT 
MOBILE UNIT; 

Have been trying to contact the 
host for the radio timeout period (2 
minutes default). 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

REBOOT MOBILE UNIT; Reboot the Mobile Unit do to loss 
of connection. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Retry (Y/N)?; Try again. Try to send or receive again, or perhaps 
ensuring the printer is cabled to the Mobile 
Unit and is on. 
 

--- 

TIMEOUT\n\nSending Data; Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Message Reason Solution Reference Tech Note 
    

TIMEOUT\n\nReceiving Data; Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Host Received Data\nAwaiting App 
Reply!; 

Mobile Unit has sent and received 
an acknowledgement from the IP 
stack and is waiting for the 
application to return data. 

Most likely host or network issue. 
Troubleshoot the customer’s environment. 
Probable causes are Database record 
locking, application program failure, Host 
failure or network failure. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

* WAITING TO SEND  *; Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

TCP Error Reading\nMAC 
Address.\nREBOOT MOBILE UNIT; 

Could not obtain the Mac Address 
from the Mobile Unit. 

Possible hardware, driver or stack problem 
Contact the Mobile Unit manufacturer. 

--- 

Invalid TIP Command; Bad internal protocol. Notify Connect over the WEB incident 
reporting system. 

--- 

Session Ended\nBy User or Host; User, Host, application or network 
has ended the session. 

If the user did not end the session, most 
likely host or network issues. Troubleshoot 
the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Server Packet Error; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 

Error receiving host\nlist from Server; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 
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Message Reason Solution Reference Tech Note 
    

Unexpected Server\ndata received; Bad Protocol detected. Usually a result of bad cabling, power or 
faulty transceiver. Also, will receive this if 
the Mobile Unit is in the wrong mode for 
server operation. 

--- 

Error starting\nhost application; Connected to the server but can 
not connect to the distant end. 

Configure the server handler to access the 
host application. 

--- 

Select Host or App; Need to choose your 
Host/application destination. 

User selection required. --- 

Connecting...; Attempting to connect to the 
Host/application. 

Advisory message. --- 

TCP Error\nReading IP 
Address\nREBOOT MOBILE UNIT; 

Mobile Unit missing Network IP 
information. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Printer start error; Could not initialize the printer. 
 
 

Cable or power issue with the printer. --- 

Battery too low\nto print; Not enough power to print. Replace the battery with a fully recharged 
battery. 
 

--- 

Paper Feed Error\nFix Then Hit Enter; Paper in the printer is not ready. Replace the paper or rethread the paper in 
the printer. 
 

--- 

Printer Error\nPrint Ended; Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

User Count Exceeded.\n Session 
Ended;  

Possible authorization issue. Verify that you have the correct number of 
licenses for the number of Mobile Units you 
are using. 
 

--- 
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Message Reason Solution Reference Tech Note 
    

Primary Unavailable\nTrying Alternate; First Host IP address not available 
trying the remaining addresses in 
the Host list. 

Verify the host address. --- 

APMAC.DAT Error\nSession Ended; Access point Media Access Control 
error. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

MUIP.DAT Error\nSession Ended;  Mobile Unit IP Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Missing Subnet IP\nSession Ended;  Mobile Unit IP Netmask Error. Most likely a Mobile Unit network setting 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error Opening File;  File is missing. Verify the configuration files are on the 
Mobile Unit.  Or perhaps there is a 
hardware failure. 

--- 

Telnet API\nnot found; Program files are missing. Reload program files. --- 

Battery Low Warning\n\nReplace 
Battery Soon;  

Not enough power to operate the 
Mobile Unit. 

Replace the battery with a fully recharged 
battery. 

--- 

No Host List.\nPress any key\nTo Edit 
Host IP's;  

Have not configured your target 
hosts. 

Configure the target host IP addresses. --- 

Unable to Allocate\nFont Memory; Mobile unit does not have enough 
memory to load the fonts. 

Reduce the fonts in use or expand the 
memory in the mobile unit. 
 

--- 

Font Loading Error; Could not load the font. 
 
 

Ensure the font is available to load. --- 
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Message Reason Solution Reference Tech Note 
    

Printer Not Ready\nPress R to Retry\nC 
to Cancel Print; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

Mobile Unit in\nDemonstration 
Mode\nfor TwinClient;  

Running in demo mode. Purchase a license from Connect. --- 

Connected to Host;  Successful connection to the target 
Host. 

Advisory message. --- 

Telnet Mode not\nsupported on\nthis 
Mobile Unit;  

This Mobile Unit must be used with 
a Connect Server. 

Order a Connect Server. --- 

Telnet Setup files\nnot found. 
Reload\nfiles then switch;  

Customer specific configuration 
files are missing. 

Load the configuration files into the Mobile 
Unit from Twin Client Manager. 

--- 

Switched Client to\nTelnet Direct Mode; Mobile Unit running in Telnet mode 
direct to the target Host. 
 

Advisory message. --- 

Switched Client to\nServer Based 
Mode;  

Mobile Unit running through a 
Connect server in thin mode 
usually at port 1800. 

Advisory message. --- 

Port 23 is only\nallowed in Telnet 
Mode;  

Can not set the port to 23 in server 
mode.  Port 23 is the standard 
Telnet port. 

Advisory message. --- 

Not Enough Memory\nTo Run; Mobile Unit does not have the 
capacity to run the program do to 
memory restrictions. 

Expand the Mobile Unit memory. --- 

Press any key; Press a key to continue. Advisory message. --- 

TwinClient Telnet;  Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

TwinClient Server;  Prompt. Advisory message. --- 

TwinClient TN3270; Prompt. Advisory message. --- 

TwinClient TN5250; Prompt. Advisory message. --- 

TwinClient TNVT/HP; Prompt. Advisory message. --- 

(c) 1991-2004 Connect; Prompt. Advisory message. --- 

Edit Menu Options; Menu Title. Advisory message. --- 

Edit Mobile Unit IP; Menu Option. Advisory message. --- 

Edit Server/Host IPs; Menu Option. Advisory message. --- 

Edit Radio Option; Menu Option. Advisory message. --- 

Edit License Key;  Menu Option. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Run Site Survey;  Menu Option. Advisory message. --- 

Switch Client Modes; Menu Option. Advisory message. --- 

Run TwinClient; Menu Option. Advisory message. --- 

Exit to OS;  Menu Option. Advisory message. --- 

Printer may not be\nplugged in 
or\nturned on!; 

Can not print. Check cable, battery, communication 
settings and paper in the printer. 

--- 

OUT OF RANGE OF BASE; Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

CONNECT SERIAL CABLE; Serial cable not connected to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 

REMOVE SERIAL CABLE; Remove serial cable from to the 
Mobile Unit. 

Check cable, battery and communication 
settings for the Mobile Unit. 

--- 

PLACE IN CRADLE; Place the Mobile Unit in the cradle. Advisory message. --- 

REMOVE FROM CRADLE; Remove Mobile Unit from the 
cradle. 

Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

ACQUIRING CRADLE BUS;  Attempting to access the cradle 
through the serial port you have 
configured. 

Advisory message. --- 

Printer Out\nOf Range; Printer out of the coverage area. Most likely range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Refused\nBy Host; You connected to the target host 
but the host disconnected you. 

Verify the configuration file has the correct 
Mobile Unit type and New environment 
variable set.  Fallback to the Connect 
Default to verify the connection. 

--- 

Connection Timed Out; You connected to the host but did 
not logon in the appropriate time so 
the host disconnected you. 

Modify the Host parameters for login. --- 

Connection Failed\nHost Not 
Responding; 

Could not connect to the Host. Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Connection Failed\nHost Unreachable; Could not connect to the Host. Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Transmit; 

Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Out\nOf Range, 
Unable\nTo Receive; 

Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

--- 

Printer Not\nResponding; Can not print. Check cable, battery, communication 
settings and paper in the printer. 
 

--- 
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Message Reason Solution Reference Tech Note 
    

Printer Out\nOf Range; Printer out of the coverage area. Most likely range, access point or radio 
issue. Troubleshoot the customer’s 
environment. 
 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Print Complete; Prompt. Advisory message. --- 

Reprint (Y/N)?; Yes or No prompt for a reprint. Advisory message. --- 

WARNING;  Prompt. Advisory message. --- 

Turning power off\nduring a 
session\nwill cause the\nprogram to 
restart; 

This Mobile Unit will disconnect the 
session if powered off. 

Mobile Unit manufacturer limitation. 
Advisory message. 

--- 

Are you sure (y/n)?; Yes or No prompt for a 
confirmation. 

Advisory message. --- 

You Sure? (YyNn); Yes or No prompt for a 
confirmation. 

Advisory message. --- 

Domain Name Server\nNot Set; DOMAIN NAME SERVER not 
configured. 

Configure the Mobile Unit with the correct 
network IP information. 

--- 

Domain Name Server\nQuery Memory 
Error; 

Memory error on the Mobile Unit Expand the Mobile Unit memory or return 
the Mobile Unit for repair. 

--- 

Domain Name Server\nQuery Sending 
Error; 

Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Domain Name Server\nQuery Receive 
Error;  

Mobile Unit out of the coverage 
area. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Domain Name Server\nUnavailable; Could not connect to the DOMAIN 
NAME SERVER. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Error loading\nparameter file; Could not load the parameter file. Reload the correct configuration files. --- 

Could not open\ntelnet interface; Could not telnet. Reload the program files. --- 

Could not set\mtelnet options; Could not use the telnet 
configuration. 

Reload the correct configuration files. --- 

Setup file\nsetting mismatch\nReload 
Setup; 

Emulation program selected is not 
compatible with the configuration 
file on the Mobile Unit. 

Remove the emulation and configuration 
files. Run clear Telnet on the Mobile Unit 
then reload the Mobile Unit with the proper 
emulation and configuration files. 

--- 

Display formatting\ntoo large 
for\ncurrent screen; 

Mobile Unit does not have enough 
memory to run your configured 
reformatted screens. 

Expand the Mobile Unit memory or order a 
server from Connect. 

--- 

Mobile Unit\ninitialization error; Mobile Unit problem. Return the Mobile Unit to the manufacturer 
for repair. 

--- 

Host/App/Network\nclosed the session; Customer’s environment 
disconnected the Mobile Unit 
session. 

Most likely range, access point, radio, host 
or network issue. Troubleshoot the 
customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 
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Disconnecting...;   Prompt. Advisory message. --- 

Scan Barcode; Bar code scanning test. Advisory message. --- 

Enter Setup\nPassword;  Prompt. Advisory message. --- 

Enter Profile \nPassword; Prompt. Advisory message. --- 

Host IP; Host IP address prompt. Enter target host IP address. --- 

Host Name; Host name prompt. Enter target host Name. --- 

Port; Host IP port required. Enter 23 for telnet or 1800 for a Connect 
server. Could also be a different number 
depending on the customer’s environment. 

T1113, T1114, T1161, 
T1171, T1187 and 
T1194 

Mobile Unit Type;  Prompt. Advisory message. --- 

WARNING: This will \nend any\ncurrent 
session; 

Prompt. Advisory message. --- 

Continue (Y/N)?; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

HOST ENTRY; Prompt. Advisory message. --- 

VT(100/220)/HP Setup; Prompt. Advisory message. --- 

Mobile Unit Info; Prompt. Advisory message. --- 

Emulation Setup; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 

Miscellaneous Setup; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Control Codes; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

<BK SP> Sends; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

New Line Mode; Prompt. Advisory message. --- 

Insert Mode; Prompt. Advisory message. --- 

Autowrap Mode; Prompt. Advisory message. --- 

Cursor; Prompt. Advisory message. --- 

EMULATION SETUP; Prompt. Advisory message. --- 

Mobile Unit Type; Prompt. Advisory message. --- 

Local Echo; Prompt. Advisory message. --- 

Map Underline; Prompt. Advisory message. --- 

Break Key; Prompt. Advisory message. --- 

ANSI Setup; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Control Codes; Prompt. Advisory message. --- 

Backspace Key; Prompt. Advisory message. --- 

MISCELLANEOUS SETUP; Prompt. Advisory message. --- 

Test Options; Prompt. Advisory message. --- 

Login Options; Prompt. Advisory message. --- 

TEST OPTIONS; Prompt. Advisory message. --- 

Printer Test; Prompt. Advisory message. --- 

Scan Code Test; Prompt. Advisory message. --- 

LOGIN OPTIONS; Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

User Password;  Prompt. Advisory message. --- 

ON; Prompt. Advisory message. --- 

OFF; Prompt. Advisory message. --- 

Map; Prompt. Advisory message. --- 

Don't Map; Prompt. Advisory message. --- 

Enable Break; Prompt. Advisory message. --- 

Disable Break; Prompt. Advisory message. --- 

7 bit; Prompt. Advisory message. --- 

8 bit; Prompt. Advisory message. --- 

Send Delete; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Send Backspace;  Prompt. Advisory message. --- 

Mobile Unit Setup; Prompt. Advisory message. --- 

Scanner Options; Prompt. Advisory message. --- 

Program Options; Prompt. Advisory message. --- 

Special Options;  Prompt. Advisory message. --- 

Beeper Options;  Prompt. Advisory message. --- 

Exit to DOS; Prompt. Advisory message. --- 

Backlight Time; Prompt. Advisory message. --- 

Enter Key Action; Prompt. Advisory message. --- 

Reset Options; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Font Size;  Prompt. Advisory message. --- 

Portable Printer; Prompt. Advisory message. --- 

Reprint Option; Prompt. Advisory message. --- 

Data IDs; Prompt. Advisory message. --- 

Internal/External; Prompt. Advisory message. --- 

Modify Beeps; Prompt. Advisory message. --- 

Message Beeps;  Prompt. Advisory message. --- 

Scan Identifier; Prompt. Advisory message. --- 

AID Scan Setup; Prompt. Advisory message. --- 

Long Scans; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Scan Send;  Prompt. Advisory message. --- 

Yes; Prompt. Advisory message. --- 

No;  Prompt. Advisory message. --- 

Normal; Prompt. Advisory message. --- 

Double Wide; Prompt. Advisory message. --- 

Double High; Prompt. Advisory message. --- 

Double High and Wide; Prompt. Advisory message. --- 

Errors Only; Prompt. Advisory message. --- 

Automatic; Prompt. Advisory message. --- 

All Messages;  Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Reject; Prompt. Advisory message. --- 

Truncate; Prompt. Advisory message. --- 

Split;  Prompt. Advisory message. --- 

Do Not Send; Prompt. Advisory message. --- 

Always Send; Prompt. Advisory message. --- 

Last Field Only; Prompt. Advisory message. --- 

Internal; Prompt. Advisory message. --- 

External; Prompt. Advisory message. --- 

none; Prompt. Advisory message. --- 

monarch; Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

pddumb; Prompt. Advisory message. --- 

comtec; Prompt. Advisory message. --- 

rascal; Prompt. Advisory message. --- 

codewriter; Prompt. Advisory message. --- 

comtec(S); Prompt. Advisory message. --- 

User Name; Prompt. Advisory message. --- 

Password;  Prompt. Advisory message. --- 

Frequency:      Hz; Prompt. Advisory message. --- 

Duration:       ms; Prompt. Advisory message. --- 

Delay:          ms;  Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

Select Scanner; Prompt. Advisory message. --- 

Setup Scanner; Prompt. Advisory message. --- 

Scan Test; Prompt. Advisory message. --- 

Scan Operation;  Prompt. Advisory message. --- 

Laser; Prompt. Advisory message. --- 

Contact/Pulse; Prompt. Advisory message. --- 

Contact/No Pulse; Prompt. Advisory message. --- 

Auto/Pulse; Prompt. Advisory message. --- 

Auto/No Pulse; Prompt. Advisory message. --- 

Wand Simulation;  Prompt. Advisory message. --- 
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Message Reason Solution Reference Tech Note 
    

VT100; Prompt. Advisory message. --- 

VT220; Prompt. Advisory message. --- 

HP700;  Prompt. Advisory message. --- 

SETUP; Prompt. Advisory message. --- 

Mobile Unit IP/Radio; Prompt. Advisory message. --- 

Host List; Prompt. Advisory message. --- 

NULL; Prompt. Advisory message. --- 



 

Twin Client Reference    •    June, 2004  12-1

 

Chapter 12 • Creating Telxon Arc Files 
 
Safe boot the terminal according to the instructions in Command Safe Boot. 
 
In Twin Client Manager, select Send Program Files to Terminal from the Terminal menu.  
 

 
 
The Telxon Arc File screen appears. Select Create a New Arc File. 
 

 
 
The Create New Arc File screen appears. Enter the name of the arc file being created. Choose either the 
AirLoader or full emulation (serial) arc file radio button. Enter the IP Settings and SSID. Click on OK. 
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A scrolling DOS screen appears. Press any key to continue. 
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The Telxon Arc File screen appears as follows. Prepare the terminal and then click on OK. 
 

 
 
A black screen appears until the connection is established. 
 

 
 
Refer to the Downloading the Arc Image section of Configuring the Terminal for Download 
for instructions on completing the download. 
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